ABSTRACT
Thank you for purchasing SIS II Sound Editor! We hope that our software will improve the quality of your tasks accomplishment.

Before getting started, read this User’s Guide (then – manual) carefully.

This paper is intended for operators who use the program SIS II as a part of a hardware and software kit IKARLab.

It contains:
1. General information about the program.
2. Requirements to hardware and software.
3. Program installation and program start.
4. Description of graphic user interface.
5. Program setting.
6. How to operate with projects.
7. How to handle sound signals.
8. Data processing.
10. Signal processing.
11. Signal analysis.
15. Operating with the signal generator.
16. Program shutdown.
17. Trouble shooting.

Any part of this publication may not be reproduced, transmitted, stored in a retrieval system or translated into any language in any form or by any means, without the written permission of Speech Technology Center, Ltd.

The contents of the SIS II software and User’s Guide are subjects to change without notice. These changes can be found in a new edition of the manual or downloaded from the STC official website: http://www.speechpro.com.
## CONTENTS

INTRODUCTION.............................................................................................................................................................................. 7
  General ...................................................................................................................................................................................... 7
  Manpower requirements .......................................................................................................................................................... 7
  Typography conventions .......................................................................................................................................................... 8
  Copyright .............................................................................................................................................................................. 9

1 GENERAL INFORMATION ......................................................................................................................................................... 10
  1.1 About the system and the producer ............................................................................................................................ 10
  1.2 Program allocation .......................................................................................................................................................... 11
  1.3 Main program functions and features ......................................................................................................................... 12

2 REQUIREMENTS TO HARDWARE AND SOFTWARE ................................................................................................... 14
  2.1 Hardware ....................................................................................................................................................................... 14
  2.2 Software tools ............................................................................................................................................................... 15

3 GETTING STARTED ................................................................................................................................................................. 16
  3.1 Program installation ......................................................................................................................................................... 16
  3.2 Program start ................................................................................................................................................................... 19

4 GRAPHIC USER INTERFACE .................................................................................................................................................. 20
  4.1 Main screen of the program ........................................................................................................................................... 20
  4.2 Menu bar and toolbar buttons ....................................................................................................................................... 21
  4.3 Toolbar ............................................................................................................................................................................. 22
  4.4 Analysis Parameters Panel ........................................................................................................................................... 22
  4.5 Workspace ...................................................................................................................................................................... 22
  4.6 Manager Panel ............................................................................................................................................................... 22
  4.7 Indication audio-volume control area ........................................................................................................................... 23
  4.8 Data string of the program ........................................................................................................................................... 24

5 PROGRAM SETTING ................................................................................................................................................................. 25
  5.1 Toolbar customization ...................................................................................................................................................... 25
  5.2 Data windows arrangement settings ............................................................................................................................... 26
  5.3 Options window of the program ................................................................................................................................... 28
    5.3.1 Structure of the options window and its opening ................................................................................................. 28
    5.3.2 Common tab ............................................................................................................................................................... 29
    5.3.3 Sound tab ................................................................................................................................................................. 30
    5.3.4 Marks tab ................................................................................................................................................................. 31
    5.3.5 Synchronization tab ................................................................................................................................................ 33
    5.3.6 Colors tab ................................................................................................................................................................. 34
    5.3.7 Path drawing tab ...................................................................................................................................................... 35
    5.3.8 Filtering tab ............................................................................................................................................................... 36

6 OPERATIONS WITH A PROJECT ........................................................................................................................................... 37

7 OPERATIONS WITH SOUND SIGNALS ............................................................................................................................. 40
  7.1 Recording sound signals .................................................................................................................................................. 40
  7.2 Opening sound files ......................................................................................................................................................... 42
  7.3 Displaying signals in the data window ........................................................................................................................... 44
# Signal Analysis

11.1 Operation with the analysis dialog box ................................................................. 102

11.2 Weighting windows .............................................................................................. 106

- 11.2.1 Theoretical reasoning for the use of windows .................................................. 106
- 11.2.2 Description of the five main windows ............................................................... 108
- 11.2.3 An equal period moving window ...................................................................... 109
- 11.2.4 Recommendations on the choice of the type of window ................................. 109

11.3 Spectrum .............................................................................................................. 110

- 11.3.1 Using Spectrum’s window ............................................................................... 110
- 11.3.2 Modifying spectrum’s construction ................................................................. 113
- 11.3.3 Creating of the on-site filters ......................................................................... 115
- 11.3.4 Using ready-made profiles ........................................................................... 116

11.4 FFT Spectrogram ............................................................................................... 118

- 11.4.1 Choice of calculation settings ........................................................................ 118
- 11.4.2 Calculation’s results ..................................................................................... 121

11.5 LPC Spectrogram ............................................................................................... 123

- 11.5.1 Material preparation ..................................................................................... 124
- 11.5.2 Choice of calculation parameters ................................................................. 125
- 11.5.3 Calculations’ results ..................................................................................... 128

11.6 Cepstrum ........................................................................................................... 129

- 11.6.1 Material preparation ..................................................................................... 130
- 11.6.2 Choice of calculation settings ........................................................................ 131
- 11.6.3 Calculation’s results ..................................................................................... 134

11.7 Autocorrelation .................................................................................................. 135

- 11.7.1 Choice of calculation parameters .................................................................. 135
- 11.7.2 Calculation’s results ..................................................................................... 137

11.8 Energy ............................................................................................................... 138

11.9 Zero Cross Frequency ....................................................................................... 140

11.10 Averaging ......................................................................................................... 142

11.11 Histogram ....................................................................................................... 144

- 11.11.1 Histogram’s construction ............................................................................. 144
- 11.11.2 Measurement of the histogram .................................................................... 146

12 EXTRACTION OF PITCH ...................................................................................... 147

- 12.1 Material preparation ......................................................................................... 148
- 12.2 Extraction ......................................................................................................... 149

13 EXTRACTION OF FORMANTS .......................................................................... 151

- 13.1 Choice of extraction parameters ...................................................................... 152
- 13.2 Extraction ......................................................................................................... 154

14 OPERATION WITH A REPORT ........................................................................... 155

- 14.1 Creation of a report .......................................................................................... 155
- 14.2 Operation with report’s text ............................................................................. 157
- 14.3 Report’s saving ................................................................................................. 158
- 14.4 Report’s removing ........................................................................................... 159

15 OPERATION WITH THE SIGNAL GENERATOR .................................................. 160
INTRODUCTION

General

The current software designed by Speech Technology Center (STC) is intended for speech signal recording, playing, editing, processing and speaker identification.

This User’s Guide contains information how to install and operate the **Sound editor SIS II**. Thus, the manual characterizes the possibilities of the solution and also describes the sound editor algorithm.

The document is primarily intended for the users having special skills in speech records assessment and describes users' actions for successful sound editing.

This paper does not replace academic, reference books and manuals from the manufacturers of the operating system and common software.

Manpower requirements

Staff, producing the installation of the specialized **Sound editor SIS II**, should have professional skills to install general and special software.

Staff, working with the dedicated **Sound editor SIS II**, should have basic skills to operate with applications in the operating systems **Microsoft Windows** and should know how to expertise speech audio/sound records.
INTRODUCTION

Typography conventions

The following typographic conventions are used in the manual:

<table>
<thead>
<tr>
<th>Font</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Body text of the manual</td>
</tr>
<tr>
<td><em>Italic</em></td>
<td>The first appearance of a term. Meaning of the term is explained here or in the appendix. Also it is used to attract <em>attention</em> or to make up notes.</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Names of <em>software components</em> and interface elements (<em>headings, buttons</em>, etc.).</td>
</tr>
<tr>
<td><strong>BoldItalic</strong></td>
<td>Names of <em>files</em> and <em>paths</em> to them.</td>
</tr>
</tbody>
</table>

Menu selection is marked with an arrow →, i.e. the combination Menu→Command should be understood as following: select Menu and then find the item Command.

To indicate the importance of any information, the following comments and notes are used in the manual:

- **Note:** Useful information
- **Warning:** Important information
- **Caution:** Essential instructions which are obligatory to be fulfilled to prevent any fatal error in the system functioning.
Copyright

**SIS II** is trademark of Speech Technology Center Ltd. All rights reserved.

All other companies and products mentioned in the manual are property of their respective owners.

The software includes modules of cross-platform application framework **Qt 4.7.0** ([http://qt.nokia.com](http://qt.nokia.com)) distributed under the terms of the GNU LGPL 2.1 license [http://www.gnu.org/licenses/lgpl-2.1.html](http://www.gnu.org/licenses/lgpl-2.1.html).
1 GENERAL INFORMATION

1.1 About the system and the producer

<table>
<thead>
<tr>
<th>Name</th>
<th>Sound editor SIS II</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conditional name</td>
<td>STC-S521</td>
</tr>
<tr>
<td>Producer</td>
<td>Speech Technology Center, Ltd.</td>
</tr>
<tr>
<td>Postal address</td>
<td>Russia, 196084, St. Petersburg, 4 Krasutskogo str.</td>
</tr>
<tr>
<td>Telephone</td>
<td>+7 812 331 0665</td>
</tr>
<tr>
<td>Fax</td>
<td>+7 (812) 327-92-97</td>
</tr>
</tbody>
</table>
1.2 Program allocation

Specialized Sound editor SIS II (then – SIS II or program) is an integral part of the hardware and software package IKARLab, as part of it intended for speech signal analysis, noise cancellation and automation of the forensic examination process of audio/sound records at all stages.

The obtained representations can be used subsequently for subjective visual analysis, as well as for:

– Taking match/mismatch decisions about compared speech samples;
– Determining specific signal properties;
– Determining individual speaker characteristics;
– Instrumental verification of phonetic and prosodic phenomena revealed at the stage of auditory linguistic examination.
1.3 Main program functions and features

Specialized **Sound editor SIS II** provides the following functions:

1. Signal digital-to-analog conversion, computer input/output via internal sound cards or external input/output devices of audio signals.
2. Playback of different parts of audio recordings, using:
   - rate correction;
   - changes in the rate of speech without altering the basic tone;
3. Audio recording editing.
4. Noise suppression and improvement of intelligibility of noise fragments of audio/sound records.
5. Setting with marks the audio recording fragments, in particular for the attribution of remarks to speakers.
6. Creating individual textual comments for every mark, text search and export to a text editor.
7. Automatic search of the comparable words in the text remarks to the recordings.
8. Calculating and visualization for:
   - oscillograms;
   - dynamic spectrograms FFT and LPC (visible speech);
   - dynamic cepstrograms (functions of signal periodicity);
   - dynamic autocorrelograms;
   - average and instantaneous spectra;
   - pitch trajectories;
   - formant trajectories;
   - signal drive;
   - histograms.
10. Loading various time signal representations into one window and control of the transparency of layers.
11. Creating and managing the projects.
12. Conversion of parameters of the spectrum construction in the filters, shape change, signal processing, using generated filters.
13. Generation of reports on the selected template.
14. Copying images, signal information, the visible speech parameters calculation onto the report.

To extend the capabilities of **SIS II**, program provides the operators with the additional modules. These software modules allow automating the execution of expert tasks, related to:

- Acceptability appraisal of audio recordings for expertise;
- Extraction of speech and noisy phonogram fragments;
- Identity analysis;
– Records authenticity control.

It should be noted that features of the program are constantly increasing and improving, so it’s recommended to specify the current additional modules on the STC official website: http://www.speechpro.com or please contact Speech Technology Center managers to find out more about.
2 REQUIREMENTS TO HARDWARE AND SOFTWARE

2.1 Hardware

**SIS II** can be delivered along with:

- I/O speech signal device (STC-H453) in the complexes **IKARLab II** and **IKARLab II+**.
- I/O sound device (STC-H246) in the complexes **IKARLab II** and **IKARLab II+**, intended for measuring characteristics and forming electrical signals in the sound frequency range.

The **SIS II** hard- and software should be installed on a PC meeting the following minimum requirements:

- CPU: Intel® Core™ 2 Duo processor 2.66 GHz;
- RAM: no less than 1 GB;
- HDD 750 GB;
- CD-ROM 48x;
- Video adapter and SVGA monitor (resolution not below 1600*1280, color quality 32 bit);
- Free USB 2.0 port to connect I/O sound device;
- Free USB 2.0 port to connect HASP software protection key;
- Keyboard, mouse;
- Speakers;
- Headphones.
2.2 Software tools

SIS II can be installed under Microsoft® Windows operating system:

– Microsoft® Windows® XP with a service pack 3 (SP3) or
– Microsoft® Windows® 7

To prepare SIS II for operation you should:

– Install the standard drivers and accompanying software for all computer hardware (especially important for a video adapter and a sound card);

– Install the latest set of audio codecs on a PC (to expand the opportunities for operating with audio files).

For correct SIS II installation and operation, you need the following additional software components to be preliminarily installed on a PC:

– Microsoft Visual C++ 2005 Redistributable 2.0.50727.762;

– Windows Installer;

– Drivers of HASP software protection key.
3.1 Program installation

Software installation must be performed by OS administrator.

The **SIS II** software protection from illegal copying and unauthorized access is performed by the **HASP** electronic protection key. The **HASP** key is included in a delivery set.

The **HASP** key must be plugged in USB port before the installation of **SIS II**. You will be offered to install the HASP driver during the software installation.

Installation of general and special software, which are in the delivery set **SIS II**, is performed by a complex installer. To install the software, run the Setup.exe file located in the root directory on the distribution disk and select the installation language (Figure 1).

![Figure 1– Installation language selection window](image)

The distribution disk contains the additional software components. The Setup Wizard will automatically determine their availability on the computer and if one of them lacks, the program offers to install it.

If any program has already been installed, it doesn’t need to be reinstalled and the previously installed components will not be displayed.

Click the **Install** button to proceed. The installation program starts. Follow its instructions.
If the additional software components have been already installed, the main window of the custom installation software will appear. Click the **SIS II** option (Figure 2).

![Figure 2 – Main window of the installation program](image)

In welcome window (Figure 3) click **Next** and follow instructions of the Installation Wizard appearing on the screen.

![Figure 3 – “Welcome” window](image)
On completion of the installation, the main installation window opens. Now it has the string “SIS II is already installed” (Figure 4).

Click **Exit** to exit the Setup Wizard program.
3.2 Program start

The utility **SIS II** starts by standard means of OS **Microsoft Windows**:

– by double clicking the icon at the desktop, or
– from the **Start** menu by the menu command **Start** → **All Programs** → **Speech Technology Center** → **SIS II** → **STC SIS II**, or

– on the Taskbar, click the icon (beforehand pin the icon to Taskbar)

If there is no HASP key, an error message will appear. In error window click **OK**, plug the HASP key into the available USB port of your computer and repeat the run procedure.

On successful launching, you will see the main window of the program, represented in Figure 5.
4 GRAPHIC USER INTERFACE

This chapter is intended to get you acquainted with the program’s graphic user interface (GUI).

4.1 Main screen of the program

When you start the program, the main screen of SIS II (Fig. 5) will appear with the user menu and toolbar at the top. The main window has the standard for OS Microsoft Windows view and consists of the following main areas:

- Menu bar;
- Toolbar;
- Vertical toolbar;
- Analysis parameters panel;
- Workspace;
- Manager panel;
- Sound level control bar;
- Status bar.

Figure 5 – SIS II main screen
4.2 Menu bar and toolbar buttons

Program header (Fig. 6) has the standard for OS Microsoft Windows view.

![Menu bar and toolbar buttons](image)

Figure 6 – Program header and menu bar

In the left corner is the name of the program, in the right– control buttons of the main window:

The **Minimize button** – allows minimizing the window up to a button on the taskbar desktop.

The **Maximize button** – allows maximizing the window to full screen (desktop).

The **Restore Down button** – allows returning the deployed window on the desktop to the original size.

The **Close button** – allows closing the main window and completing the work.

The main screen’s menu bar contains menus (Fig. 6) with all functions and operations provided in the program. They are listed thereunder:

- **File** menu commands and the according toolbar buttons provide managing files and projects.
- **Edit** menu commands provide data editing functions.
- **View** menu commands provide managing display settings of data windows and copying data to the clipboard.
- **Playback** menu commands provide controlling a signal playback.
- **Processing** menu commands provide data processing functions.
- **Analysis** menu commands provide managing the sound signals analysis.
- **Marks** menu commands provide handling with constant marks.
- **Service** menu commands are intended for adjusting the program and generating different kinds of signals.
- **Modules** menu commands provide attaching and managing additional software modules (plug-ins).
- **Windows** menu commands provide handling with data windows.
- **Help** menu commands provide getting brief information about the program and opening the current User’s Guide as an Adobe Acrobat PDF file.

Particular items and menu commands are listed below in the description of the program.
4.3 Toolbar
To accelerate the selection of individual items and commands of the main menu, the program provides horizontal and vertical toolbars. The toolbar buttons supplement and duplicate some of the menu commands.

On the horizontal toolbar, icons duplicate **File, Edit, View, Playback, Processing, Windows** menus’ commands.

The vertical toolbar is located on the left side of the SIS II main screen and duplicate some of the **Analysis and Service** menus’ commands.

A complete list of icons of the horizontal toolbar and of the Menu bar is given in Appendix B of this guide.

A complete list of icons in the vertical toolbar is given in Appendix C of this guide.

For more information, see “Toolbar customization” in Subsection 5.1 of this manual.

4.4 Analysis Parameters Panel
This panel includes parameters dialog boxes that appear when you invoke calculation of a spectrum, spectrogram, cepstrum, LPC or autocorrelation by using the **Analysis** menu commands or buttons of the vertical toolbar.

For more details, see “Operation with the analysis dialog box” in Subsection 11.1 of the manual.

4.5 Workspace

The workspace is an area where open data windows are displayed.

4.6 Manager Panel

The Manager Panel (Fig. 7) consists of three tabs: **Windows, Marks** and **Projects**.

![Manager Panel](image)

Figure 7 – Manager Panel

The Manager Panel is intended for controlling the data windows (for more information, see the **Windows tab** in Subsection 8.2, “Data window’s operations”), marks (for more information, see the **Marks tab** in Subsection 7.4.5, “Marks tab of the Manager Panel”) and projects (for more information, see the **Projects tab** in Subsection 6, “Operations with a project”).

The Manager Panel can be closed or opened again by clicking the **Manager Panel** command on the **View** menu of the Menu bar, or press **F10**.
4.7 Indication audio-volume control area

At the bottom of the main window, an indication audio-volume control area is located (Fig. 8). The area can be removed or returned to the place, using the **View → Sound level** menu commands. The sound level is displayed individually on the left or right channels’ indicators.

![Figure 8 – Indication audio-volume control area](image)

There are the following modes of the volume:

1) Separate volume control mode in the left and right channel. In this case, clicking the speaker icon the playback of sound can be switched off at any of the channels (Fig. 9).

![Figure 9 – Separate volume control mode, one channel is disabled](image)

2) Synchronous audio-volume control mode in both channels. In this case, volume changes in both channels simultaneously, and when clicking the speaker icon at any of the channels, audio playback turns off in both channels (Fig. 10).

![Figure 10 – Synchronous audio-volume control mode (a). Both channels are turned off (b)](image)

Switching of modes is carried out by clicking the icon or .

---

**GRAPHIC USER INTERFACE**

---

23
4.8 Data string of the program

| X: 0:13.066 | Y: 1558.2 | 8000/16-bit | Stereo | 2.59 Mb | 1:24.932 |

Figure 11 – Data string of the main program window

In data string of the program (from the left to the right) the following information about the data of the active tab is displayed (Fig. 11):

- Coordinates of the cursor within the data displayed in the window, X: and Y:
- The beginning, the end (in square brackets) and duration of the highlighted fragment (if selected);
- Type of data (for oscillograms: sampling rate and accuracy of digitization);
- Type of the signal: mono or stereo;
- File size;
- Overall length of audio / sound record.
5 PROGRAM SETTING

5.1 Toolbar customization

To accelerate the choice of the right command, the operator is given the opportunity to customize the toolbar. To change the content of the toolbar:

1) On the View menu, click **Customize Toolbar…**

2) In the Toolbar Customization dialog box (Fig. 12, a), select necessary check box and press the button on its right.

3) In the Toolbar Customization dialog box (Fig. 12, b):
   - Select necessary check boxes to be displayed on the toolbar;
   - Choose an icon and, using the Up and Down buttons, allocate it as consistent with other icons;
   - Click the Close button.

The icons of the toolbar will change its composition and location on the toolbar. If you press the Close button in the Toolbar Customization box, the window will be closed without applying your changes.

4) Follow steps 2) and 3) to configure other toolbars.

5) After setting the toolbar in the configuration toolbar window (see Fig. 12, a) click **OK**.
5.2 Data windows arrangement settings

In order to simplify the arrangement of the data windows, you may set a fixed windows’ position with the window grid at the central workspace of the main window and save the specified arrangement as a particular profile.

A grid setting is accomplished at the window **Arrange windows** (Fig. 13), which is opened by clicking the sign of the **Grid Mode** pictogram on the toolbar.

![Figure 13 – "Arrange windows"](image)

To create a new type of the grid profile:

1) Click the **New Profile**… button in the **Arrange windows** window. The variant 1x1 will appear in the drop-down list and in the area of a grid formatting.

2) Set the needed number of columns and rows.

3) If it is necessary, change the size of a column or a row:
   - move the cursor to an appropriate border;
   - after cursor assumed the shape of bidirectional arrow, press the left mouse button and drag the border to a needed place.

4) Click the **Make Equal Size** button, if you want to make size of the cells equal.

5) Click the **Save** button. The new variant will be saved into the drop-down list of profiles.

In order to correct an available profile, select it in the drop-down list and accomplish the points 2-5 as for the creating of a new profile.

To remove a profile from the list:
1) Select the profile from the drop-down list;
2) Click the **Delete profile** button.

Besides creating or selecting a grid profile in the *Arrange windows* window it is also possible to specify **Window Mode**, which will be applied when clicking the **Grid Mode** pictogram or clicking **Grid Mode** in the *Windows* menu (*Windows → Grid Mode*):

- **Free** – the user may arrange windows randomly. The program turns to this mode after repeated clicking the **Grid Mode** pictogram or clicking **Grid Mode** in the *Windows* menu (*Windows → Grid Mode*);
- **Horizontal** – the windows are arranged horizontally, one under another;
- **Vertical** – the windows are arranged vertically, side by side;
- **Grid** – the windows are arranged in accordance with the chosen windows grid profile.

To apply the chosen window mode, click the **OK** button; to cancel the applying of chosen mode, click **Cancel**.
5.3 Options window of the program

5.3.1 Structure of the options window and its opening

The majority of options of the program are set by default and do not need to be modified by the user. You may change the options in the **Options** window, if it is necessary. On the **Service** menu, click **Options (Service → Options)** to open this window.

The **Options** window consists of seven tabs:

1. **Common** – provides selecting the interface language, the number of undo levels and also various parameters of a data displaying.
2. **Sound** – provides selecting the playback and record devices and set the parameters of recording.
3. **Marks** – provides setting the color and font of marks.
4. **Synchronization** – provides setting the parameters of synchronization among the windows.
5. **Colors** – provides selecting the colors for horizontal marks, 2D cursor, background, axes and text of axes in the data window.
6. **Path drawing** – provides setting the parameters of path drawing.
7. **Filtering** – provides setting the parameters of filter contrasting.

In order to apply the new options, click the **OK** button in the **Options** window.

In order to cancel the made changes, click the **Cancel** button.
5.3.2 Common tab

On the **Common** tab of the **Options** window (Fig. 14), it is possible to:

1) Select the interface language: **English**, **Russian** or **Spanish**.

2) Select the **Display time in seconds** check box. In this case the time scale in the data windows won’t be displayed with seconds but with the format hh.mm.ss.

3) Set the percentage of the mouse wheel zoom factor.

4) Set the number of undo levels.

5) Select the **Restore configuration at launch** check box. Then at the next launch of the program, its configuration, saved before the previous shutdown, will be restored.

6) Select the **Highlight selected** check box. In this case when selecting the data fragment, it will be highlighted with another color.

7) Select the **Highlight selected intervals** check box. In this case selected (in the list of marks) intervals will be highlighted with another color.

8) Select the **Attach 3D features to waveform window** check box. It links all new windows of 3D features with the window of original signal.
5.3.3 Sound tab

![Sound tab of the Options window](image)

On the **Sound** tab of the **Options** window (Fig. 15), it is possible to:

1) Select the playback device from the drop-down list.
2) Select the record device from the drop-down list.

- **Use the sound input/output device manufactured by Speech Technology Center, Ltd. for both these purposes.**
- **In the operating system Microsoft Windows 7 the devices in the drop-down lists are shown only if the headphones and microphones are attached to them.**

3) Select from the drop-down list the sampling rate: **8000, 11025, 16000, 22050, 32000, 44100, 48000, 88200, 96000** Hz or set its arbitrary value in the proper window using the keyboard.
4) Select from the drop-down list the recorded channels: **Stereo, Mono** or **Mixed Mono**.
5) Select from the drop-down list the signal resolution: **16 bit** or **24 bit**.
6) Select the **Mute output** check box. In this case a signal being recorded won’t be played back while recording.
5.3.4 Marks tab

![Figure 16 – “Marks” tab of the “Options” window](image)

On the **Marks** tab of the **Options** window (Fig. 16), it is possible to:

1. Select color of the marks (Fig. 17).
2. Select font of the marks (Fig. 18).
Figure 17 – “Select Color” window

Figure 18 – “Select Font” window
5.3.5 Synchronization tab

The synchronization enables to simplify and reduce the number of user’s actions for displaying, highlighting and marking up the common data ranges in different windows.

On the **Synchronization** tab of the **Options** window (Fig. 19), it is possible to:

1) Select the **Synchronize displaying range for windows linked by X axis** check box.
2) Select the **Synchronize displaying range for windows linked by Y axis** check box.

Having changed a data range, displayed in one of the windows, you will get a synchronized change of displaying in other windows.

3) Select the **Synchronize signal “selection” by X axis in window linked by X axis** check box. In this case the highlighting in one window will be duplicated automatically in all other windows linked to that by X axis.
4) Select the **Copy new Y axis marks into windows linked by Y axis** check box.

When the copying function is turned on, the marks, putted in one of linked windows, will be duplicated automatically in all other windows. Thus user will not need to put them in each window particularly.
5.3.6 Colors tab

There is color adjustment of each element of the data windows to optimize their representation.

![Figure 20 – “Colors” tab of the “Options” window](image)

On the Colors tab of the Options window (Fig. 20), it is possible to click the Custom... button to choose a color for the following elements:

1) Horizontal marks;
2) 2D cursor;
3) Background of the displaying area.
4) Vertical and horizontal axes.
5) Axes’ text.

Color is chosen as in the window on Fig 17.
5.3.7 Path drawing tab

To increase clearness and efficiency of the formant trajectories drawing on the Path drawing tab of the Options window (Fig. 21), it is possible to:

1) Select the method of the signal representation: select the line drawing style: Polyline, Stair-step line or Dots. When selecting Dots, it is also possible to set a maximum of dots per pixel.

2) Select the method of the formant drawing: Stair-step or Linear Approximation. Here you may also set the line thickness within the range from 1 to 5.

3) Assign the following parameters for the formant paths:
   – Frequency search range from 10 to 500 Hz;
   – Number of averaging spectra from 1 to 33;
   – Sound frequency hint line color;
   – Formant path color.

It’s possible to choose color in the dialog box, as on the figure 17, by clicking the proper button.
4) Set for the pitch paths:
– frequency search range from 10 to 300 Hz;
– number of averaging cepstra from 1 to 33.

5.3.8 Filtering tab
This tab provides turning on the filter contrasting mode, which will be performed automatically while calculating the inversed filter or automatic filtering.

*Contrasting* is the automatic detecting, extension and deepening of narrow gaps in the filter characteristic. This operation provides increasing the filtering quality especially when there are explicit peaks of local interferences.

This function is available after selecting the **Filter contrasting** check box (Fig. 22) on the **Filtering** tab of the **Options** window. There you can also assign the function’s parameters:

1) Discrimination level from 0 to 1.

*Discrimination level* (the ratio of filter’s value in the gap to its value on the edge) is used by the program for detecting a gap to apply the contrasting operation for it.

The value 1 means that all local minima will be contrasted; the value 0 means that the filter will not be changed. For the values nearby 0.5 a little natural indentation will be overlooked and explicit minima will be contrasted.

2) Analysis window’s width from 0 to 10 000 Hz.

It sets the maximal width of gap that will be considered as “narrow” and then will be contrasted. This parameter is 70 Hz by default.

3) Selecting the **High intensity** check box provides expanding the gaps when contrasting.
6 OPERATIONS WITH A PROJECT

It’s recommended to process all materials of a particular expertise within a project to make them easily accessible. The *project* is the set of files referred to a concrete expertise. You can add to a project both the files created by the program and the files of either format: audio, video and text.

When adding a file to a project, the reference to a file location on the hard disk will be saved. When removing a project or a file from a project, the references to files will be removed, but the proper files on the logical partition won’t be.

On the *File* menu, click **Project Management** and then click **Create Project...** *(File ➔ Project Management ➔ Create Project...)* to create a new project. You’ll see the **Create New Project** window shown on the figure 23.

![Create New Project window](image)

**Figure 23 – “Creating New Project” window**

Perform the following actions in the **Create New Project** window:

1) Type a project name in the **Project Name:** field. Spaces in the project name are prohibited, thus in case of having done them the program will notify you with an error message and suggest you to change the text.

2) Set or select the path to a project folder in the **Project Location:** field.

   The path is **Documents** by default. Click the button to select another path. Then choose or create a new folder in the **Find Directory** dialog box and click the **Choose** button.

3) Enter necessary comment for the project in the **Comment:** field.

4) Click the **Create** button. Created project will appear at the **Projects** tab of the **Manager Panel**, and its file will be created at the projects’ folder.

Click the **Cancel** button, if you do not want to create a new project.

In order to add a project, located on the hard disk, to the **Projects** tab of the **Manager Panel** (if it was removed from there, for instance):

1) Click the right mouse button on the empty area of the **Projects** tab.
2) Select the **Add existing project** command in the context menu.

3) In the **Open File** dialog box choose a project's file (*spj*) and click the **Open** button.

Context menu of a project or a folder (Fig. 24) makes it possible to:

- **Add File(s)** – open the **Open File** dialog box for choosing or adding the file to a project or a folder.
- **Remove** – remove a project or a folder with all the references to the files added to them. Meanwhile the proper files remain on the hard disk. Removing process requires the confirmation: click the **Yes** button to confirm the removing or **No** button to cancel it (Fig. 25).

- **Add Folder** – add a folder to the project or folder. The folder has the same context menu as a project's one, but it refers to the folder (Fig. 26).

- **Rename** – change the name of the project of folder.

There are two menu items for the files of a project (Fig. 27):
OPERATIONS WITH A PROJECT

Figure 27 – File context menu

– **Add File(s)** – opens the **Open File** dialog box for choosing and adding other files to the existing one, for example, files of saved fragments or new data taken from processing and analysis.

– **Remove** – remove the reference to a chosen file. A proper file remains on the disk as well. Removing process requires the confirmation (see Fig. 25 b).

To open the project file’s contents on the data window:

1) Select a file on the **Projects** tab of the **Manager Panel**.

2) Double-click on it with the left mouse button.
7 OPERATIONS WITH SOUND SIGNALS

7.1 Recording sound signals

The program enables to record the sound signal using the parameters set on the Sound tab of the Options window. The parameters are set by default:

- Sampling rate – 11025 Hz;
- Recorded Channels – Stereo;
- Signal resolution – 16 bit;
- Mute output is off.

In order to change some parameters of the recording:

1) In the Service menu click Options (Service → Options).
2) Choose the Sound tab in the Options window.
3) Change the recording parameters.
4) Click the OK button in the Options window.

Before starting recording:

1) Plug-in the microphones and the sound I/O device as shown in the documents.
2) Make sure that you have chosen the sound I/O device as the record device on the Sound tab of the Options window.

Use one of the following methods to start recording:

1) In the File menu click Recording (File → Recording).
2) Click the Recording pictogram on the toolbar.
3) Press Ctrl+R on the keyboard.

You will see a recording time at the field of the toolbar, a signal level on the volume indicators and an oscillogram of a recording signal (Fig. 28).

Figure 28 – Oscillogram of a recording signal
Use one of the following methods to pause the recording:

1) In the **Playback** menu click **Pause (Playback → Pause)**.

2) Click the **Pause** pictogram on the toolbar.

3) Press **Ctrl+P** or the **Spacebar** key on the keyboard.

Repeat one of the following actions to resume recording:

1) In the **Playback** menu click **Pause (Playback → Pause)**.

2) Click the **Pause** pictogram on the toolbar.

3) Press **Ctrl+P** or the **Spacebar** key on the keyboard.

Use one of the following methods to finish recording:

1) In the **File** menu click **Recording (File → Recording)** again.

2) Click the **Recording** pictogram on the toolbar again.

3) Press **Ctrl+R** on the keyboard again.

4) In the **Playback** menu click **Stop (Playback → Stop)**.

5) Click the **Stop** pictogram on the toolbar.

6) Press **Esc** key on the keyboard.

If you click the **Close** button in the data window of the oscillogram of a signal being recorded, a warning will be shown. It is recommended to save the record in order not to lose recorded data. To perform it, in the **File** menu click **Save** or **Save As...**, or click the **Save** pictogram on the toolbar. Choose the folder to save in the **Save** dialog box, point the file name and its type (**.dat** or **.wav**) and click the **Save** button.
7.2 Opening sound files

The program provides opening of sound files of the following formats:

- **wav** – the Microsoft format for storing a digital audio stream;
- **dat** – the format of the Sound Editor SIS II by STC;
- the possibility to open the files of other formats depends on the availability of a proper codec in the operation system.

Please perform the following actions to open a file:

1) In the File menu click **Open (File → Open)**, click the Open pictogram on the toolbar or press **Ctrl+O** on the keyboard.

2) Choose necessary file in the **Open File** dialog box and click the Open button (Fig. 29).

If the program recognizes the file format, you’ll see the data window within workspace on the main window and the contents of a chosen file will be shown as the oscillogram (see Fig. 30).
Information about the opened file appears at the information panel in the bottom right corner of the main program window (Fig. 11).
7.3 Displaying signals in the data window

7.3.1 Areas of the data window

Generally the window consists of the following areas (Fig. 31):

1 – Heading;
2 – Navigation oscillogram;
3 – Area of the data visible in the window;
4 – Horizontal scrollbar;
5 – Marks list (see the subsection 7.4 Signals marking of this manual).

![Data window](image)
7.3.2 Data window heading

The data window heading consists of:

1) The window name – an upper- or lowercase English letter. The program assigns them automatically and subsequently.

2) The data tab name – a name of the opened audio record or other data. The data tab contains the Close Tab button, which provides closing of this tab in the window and removing its data from the program.

3) The button for adding data from files – it opens the Open File dialog box where a user can choose the necessary file.

After choosing a file in the data window a new tab appears and becomes active (Fig. 32):

– The oscillogram of an entire signal, recorded in a file, is displayed in the area of navigation oscillogram.

– A new data tinctured with its own color is displayed in the area of data visible in the window. You can change the color of data selecting it in the Select Color dialog box, which can be opened by clicking Choose Signal Color… on the View menu (View → Choose Signal Color…).

– The list of marks of the new signal is displayed in the area of the marks list, if they were put previously.

Click on any tab’s heading with the left mouse button to make a tab active. The data window contents will be changed correspondingly.

Use one of the following methods to make a data window active:

– select a data window in the program workspace;

– select data window name in the list of windows in Windows menu;

– select data window name in the Windows tab of the Manager Panel;

The chosen window will be highlighted with yellow.
4) There are the data window control buttons in the program:

- The **Minimize button** – provides minimizing the data window to a button-size window at the bottom of workspace of main program window.

- The **Maximize button** – provides maximizing data window to occupy the entire central workspace of the main program window.

- The **Restore button** – provides restoring a minimized data window to its previous size.

- The **Close button** – provides closing the data window with all its tabs and remove their data from the program.
7.3.3 Navigation oscillogram

The navigation oscillogram shows visually what part of a signal is displayed in the area of data visible in the window. This area might not be shown for several data types such as formants and histograms.

The area of data visible in the window is highlighted at the navigation oscillogram. Any change of the data area is displayed at the navigation oscillogram as well.

You can increase or decrease the area of data visible in the window using the navigation oscillogram (Fig. 33, a). To perform it:

1) Move the cursor to the edge of a highlighted area of the navigation oscillogram until it assumes the shape of a bidirectional arrow.
2) Press the left mouse button and drag the border to a place you need. Meanwhile the size of the horizontal scroll box will be changed subsequently.

In order to move the area of data visible in the window to another place on the horizontal scale, move the cursor to a highlighted area of the navigation oscillogram until it transforms to the opened palm. While the cursor assumes this shape, press the left mouse button and drag the highlighted area to a necessary signal position.

With the navigation oscillogram you can easily set the area of data visible in the window at any signal position. To perform it:

1) Move the cursor to the beginning of the data area.
2) Press the left mouse button and drag the cursor to the end of the data area (Fig. 33, b). The position and size of the horizontal scroll box will change subsequently.

Figure 33 – Changing of the size (a) and the selecting (b) of the area of data visible in window at the navigation oscillogram
7.3.4 Area of data visible in the window

The area of data visible in the window provides the ample opportunities for browsing both entire data and any part of them.

It may be changed with:

– the View menu;
– the context menu of the data window and the scroll bar, which may be opened by moving the cursor to them and clicking the right mouse button;
– the mouse wheel when pointing the cursor to the horizontal or vertical scale;
– the horizontal scroll bar;
– the vertical scroll bar.

Use one of the following methods to display the entire signal:

1) In the View menu click Entire Signal (View → Entire Signal).

2) Click the Entire Signal pictogram on the toolbar.

3) Press the F8 key on the keyboard.

In order to display only the selected data fragment (the selection of a fragment is described in the subsection 7.4 Signals marking of this manual), use one of the following methods:

1) In the View menu click Selected (View → Selected).

2) Click the Selected pictogram on the toolbar.

3) Press Shift+F8 on the keyboard.

In order to change the data representation by the Y axis, use one of the following methods:

1) In the View menu click In dB (View → In dB).

2) Select the In dB item in the context menu of the data window.

3) Click the dB In dB pictogram on the toolbar.

Depending on the current state the scale of the Y axis and the data representation will be changed in concordance.

Use one of the following methods to extend the data on the entire height of area:

1) In the View menu click Vertical Auto-zoom (View → Vertical Auto-zoom).

2) Select the Vertical Auto-zoom item in the context menu of the data window.

3) Click the Vertical Auto-zoom pictogram on the toolbar.

In order to move the image visible in the window forward or back on its own size, use the Next Page or Previous Page commands of the View menu, or press the PgUp or PgDown key on the keyboard respectively.

The program provides changing the borders of data visible in the window within a wide range (Fig. 34).
If you move the cursor to the vertical (Fig. 34, pos. 1) or horizontal (Fig. 34, pos. 2) scale and rotate the mouse wheel, the scale spacing, displayed in the window, will be increased or decreased and the data range visible in the window will be changed correspondingly. The data range will be expanded or narrowed around the current cursor position.

If the data visible in the window isn’t shown entirely, a scroll box will appear on the horizontal scroll bar under the horizontal scale (Fig. 34, pos. 4). The scroll box’s size is proportional to the size of the data visible in the window, and its position on the scroll bar is in accordance with the data position on the scale. Also the buttons (Fig. 34, pos. 3 and 5) will be activated on the both edges of the horizontal scroll bar.
7.3.5 Horizontal scroll bar

In order to move the area of data visible in the window to another position on the horizontal scale, use the horizontal scroll bar as follows:

1) Click the button to move the scroll box to the left (Fig. 34, pos. 3).
2) Click the button to move the scroll box to the right (Fig. 34, pos. 5).
3) Move the cursor to the scroll box (Fig. 34, pos. 4), then press the left mouse button and drag it to the necessary direction.
4) Move the cursor to any position on the horizontal scroll bar, where the scroll box is not located, and click the left mouse button. The scroll box will be moved in the direction of the cursor on the value of its own size.
5) Move the cursor to the horizontal scroll bar and click the right mouse button. A context menu will appear with the following commands:
   - **Scroll here** – the left scroll box edge moves to the cursor’s position;
   - **Left edge** – the visible data area moves to the beginning of the horizontal scale;
   - **Right edge** – the visible data area moves to the end of the horizontal scale;
   - **Page left** – if the cursor is on the left of the scroll box, the action is the same as in the method 4, described above;
   - **Page right** – if the cursor is on the right of the scroll box, the action is the same as in the method 4, described above;
   - **Scroll left** – this action is just the same as the 1 method;
   - **Scroll right** – this action is just the same as the 2 method.
7.3.6 Moving and size changing of the data window

To change the data window’s size:

1) Move the cursor to the window edge until it assumes the shape of bidirectional arrow.
2) Press the left mouse button and drag the window’s edge in the necessary direction.

To move the data window wholly:

1) Move the cursor to the window edge until it assumes the shape of open palm.
2) Press the left mouse button and drag the window to another place of the program workspace.

A random moving and data window’s size changing are available in the Free mode. If the Grid Mode is selected in the Windows menu or the Grid Mode pictogram on the toolbar is pressed, then windows’ size will be determined by the size of the cells where the windows located. You can move the windows only from one cell to another one.
7.3.7 Zoom mode

The zoom scale mode helps to descry a data fragment in details.

Click the \textit{Zoom} pictogram on the vertical toolbar or in the \textit{Service} menu click \textit{Zoom (Service \rightarrow Zoom)} to use this mode.

In the area of data visible in the window, a dashed rectangle with the horizontal dashed line in the middle will appear (Fig. 35).

![Figure 35 – Applying of the zoom mode](image)

If the left mouse button is pressed, the rectangle sizes can be modified. The right and the bottom edges of the window will move following the cursor.

If release the left mouse button and move the mouse, the whole rectangle will move following the mouse.

Move the rectangle to the data fragment you are interested in, and click the right mouse button. The data, got to the rectangle, will be displayed in the range of the data visible in the window.

At the same time the middle of visible data range will coincide with the horizontal dashed line in the middle of the rectangle.

Press the \textit{Esc} key on the keyboard to cancel the zoom mode.

In order to display the whole data range in the window, click the \textit{Entire Signal} and \textit{Vertical Auto-zoom} pictograms on the toolbar or click \textit{Entire Signal} and \textit{Vertical Auto-zoom} on the \textit{View} menu.
7.4 Signals marking

7.4.1 2D cursor and horizontal marks

Horizontal mark can be put only with the 2D cursor in the data window. Use one of the following methods to apply the 2D cursor:

1) Press the Ctrl key on the keyboard and click the right mouse button simultaneously.
2) Click the 2D cursor pictogram on the vertical toolbar.
3) On the Service menu click 2D cursor (Service → 2D cursor).

You will see the cursor in the form of two crossing lines in the active tab of the data window (Fig. 36).

![Figure 36 – 2D cursor in the data window](image)

The point of intersection moves following the mouse. The positions of the vertical and horizontal cursor’s lines on the scales are marked with the triangles; nearby these triangles the values of corresponding coordinates are displayed. Click the right mouse button to put the horizontal mark. On the horizontal cursor’s line position the horizontal mark will appear.

Press the Esc key on the keyboard to cancel the 2D cursor operation in the data window.

After having canceled the 2D cursor operation, the horizontal mark can be displaced. To perform it:

1) Move the cursor to the mark until it assumes the shape of bidirectional arrow (Fig. 37).
2) Press the left mouse button and drag the mark in the necessary direction.

![Figure 37 – Horizontal mark displacing](image)

In order to remove a horizontal mark move the cursor to the mark until it assumes the shape of bidirectional arrow, then use one of the following methods:
1) Press **Alt+Delete**.

2) Click the right mouse button and select the **Remove Mark** item in the context menu.

In order to remove all the horizontal marks, in the **Marks** menu click **Remove Horizontal Marks** (**Marks → Remove Horizontal Marks**).
7.4.2 Single marks

In order to put a single mark on the position of vertical 2D cursor’s line, press the hot key, assigned for the single marks on the Marks tab of the Manager Panel (it is the Insert key by default). The single mark will appear at the vertical line’s position.

You can put also single marks in the data window without the 2D cursor. Move the mouse cursor to a necessary position in the area of data visible in the window and use one of the following methods (Fig. 38):

1) Press the hot key assigned for the single marks.

2) Press the Ctrl key on the keyboard and then double-click the left mouse button.

![Figure 38 – Single marks](image)

If you click the left mouse button while the mouse cursor is in the area of data visible in the window, the cursor will appear as the vertical dashed line.

The put marks appear not only in the area of data visible in the window, but also at the navigation oscillogram and in the list of the Single group of marks.

To move the single mark:

1) Move the mouse cursor onto it.

2) Press the Shift or Ctrl key on the keyboard.

3) Press the left mouse button.

4) Move the mark without releasing the Shift or Ctrl key and the left mouse button.

5) Release the left mouse button and the Shift or Ctrl key.

To remove the single mark, use one of the following methods:

1) Move the mouse cursor onto the single mark you want to remove and press Ctrl+Delete.

2) Move the mouse cursor onto the single mark you want to remove, click the right mouse button and select the Delete mark item in the context menu.

In order to remove all the vertical marks, on the Marks menu click Remove Vertical Marks (Marks → Remove Vertical Marks).
7.4.3 Highlighting a signal fragment

In order to highlight a signal fragment, perform the following actions:

1) Move the mouse cursor to the beginning of the fragment.
2) Press the left mouse button and without releasing it move the cursor to the end of the fragment being highlighted.
3) Release the left mouse button.

The selected fragment (interval) will be highlighted with another color (if the Highlight selected intervals check box was selected on the Common tab of the Options window) and limited with two vertical dotted lines (Fig. 39 a).

To move the border of the selected interval:

1) Move the cursor to the interval’s border until it assumes the shape shown on Fig. 39 a.
2) Press the left mouse button and drag the border to the needed position.

The way you move a border in the area of data visible in the window you can move the vertical cursor (see Fig. 39 b).
### 7.4.4 Interval Marks

The highlighted signal fragments can be noted with the interval marks (Fig. 40).

To perform it, highlight the signal fragment (interval) and press the hot key, assigned to a determined marks subgroup on the **Marks** tab of the **Manager Panel**.

The highlighted interval will be indicated with a rectangle of the same color that was determined for the marks subgroup on the **Marks** tab of the **Manager Panel**, and also will be added to the list of marks of the proper subgroup located under the horizontal scroll bar.

Put interval marks are displayed also at the navigation oscillogram.

All vertical marks are counted in the marks list. The list may be minimized or maximized by using the buttons located on the right of the horizontal scroll bar.

![Figure 40 – Noted interval marks](image)

To move one of the interval’s border:

1) Move the cursor to that border.

2) Press the **Shift** key on the keyboard.

3) Press the left mouse button.

4) Without releasing the **Shift** key and the left mouse button move the border of the paired mark to the necessary position.

5) Release the left mouse button and the **Shift** key.

To move the entire interval:
1) Move the mouse cursor to one of the interval’s borders.
2) Press the Ctrl key on the keyboard.
3) Press the left mouse button.
4) Without releasing the Ctrl key and the left mouse button move the interval mark to the necessary position.
5) Release the left mouse button and the Ctrl key.

To remove an interval mark, use one of the following methods:
1) Move the mouse cursor to one of the border of the mark you want to remove and press Ctrl+Delete.
2) Move the mouse cursor to one of the border of the mark you want to remove, click the right mouse button and select the Remove Mark item in the context menu.

To remove all the vertical marks, on the Marks menu click Remove Vertical Marks (Marks ➔ Remove Vertical Marks).
7.4.5 “Marks” tab of the Manager Panel

The marks management is realized on the **Marks** tab of the **Manager Panel** (Fig. 41).

![Figure 41 – “Marks” tab of the Manager Panel](image)

The **Marks** tab consists of its own toolbar, groups and subgroups structure and the information field at the bottom of the window.

There are the following pictograms on the toolbar of the **Marks** tab:

- ![Create New Group](image) **Create New Group.** This pictogram provides adding a new mark group to the list of groups and subgroups. The group is added to the previously selected group, subgroup or to the common list, if nothing was selected.

- ![Delete Group](image) **Delete Group.** This pictogram provides removing of a selected group or subgroup.

- ![Save Template](image) **Save Template.** This pictogram provides saving of an individual user template of the marks structure in a particular file.

- ![Load Template](image) **Load Template.** This pictogram provides loading of an individual user template of the marks structure from a previously saved file.

- ![Add Mark](image) **Add Mark.** This pictogram provides adding a mark in the area of displaying of the data window. The interval you want to mark should be highlighted as a fragment previously, then the proper group or subgroup should be selected in the list.

- ![Place next mark above](image) **Place next mark above.** This pictogram provides conjunction of a next mark with a previous one.
**Column Visibility.** This pictogram provides determining the columns’ structure in the list of groups and subgroups.

There are the following columns in the group and subgroup structure (see Fig. 41):

- **Name** – the name of a group or subgroup.
- **Color** – the color of marks of a given group.
- **Key** – the hot key for choosing the marks of a given group.
- **Selected** – provides selection of all marks of a given group when this check mark is put.
- **Group Visible** – determines the visibility of the marks of a given group in the data window.
- **Text Visible** – determines the visibility of the tab of a given group in the list of marks located in the data window.

The information field at the bottom of the **Marks** tab displays for a selected group the number of marks in the group and their total duration.

There are the following groups in the marks structure by default: **Single**, **Sounds**, **Noises**, **VAD**, also there is the group **Speakers**, which includes the voices of two men (**M1** and **M2**) and two women (**F1** and **F2**).

The user can create an arbitrary collection of groups and subgroups and save it as a template.

The structure of groups and subgroups of marks and their properties (color, hot keys and visibility) created on the **Marks** tab is linked to a concrete audio file the marks were created for.

The marks created for the processed in the program audio file are saved by default in the file with the same name that the audio file has but with the extension ***.meta**. Thus when a given audio file is opened again in the program, the list and the structure of marks will coincide with the previously created ones.

It is recommended to save the most frequently used marks' structures as templates to reduce the time of mark’s creating for a new audio file. To perform it:

1) Click the **Save Template** pictogram on the **Marks** tab.
2) Choose a folder to save the template in the **Save template file as** dialog box, enter the template file name and click the **Save** button.

To use a previously saved template of marks structure, perform the following actions:

1) Click the **Load Template** pictogram on the **Marks** tab.
2) Choose the necessary template file in the **Load template file as** dialog box and click the **Open** button.

If you want to add a proper group’s mark in the data window using the **Marks** tab, use the following methods:

1) For a single mark:
   - move the vertical cursor to the needed position;
   - select or create the **Single** marks group on the **Marks** tab;
   - click the **Add Mark** pictogram.
2) For an interval mark:
   - highlight the needed interval (fragment) in the data window;
– select or create the necessary interval marks group (subgroup) on the Marks tab;
– click the Add Mark pictogram.

If the Place next mark above pictogram is pressed while putting another mark, then the left border of a new mark will start from the right border of the previous mark of a given group, regardless of how the current data interval was highlighted.

In order to add a new group to the group structure on the Marks tab, select the group in which a new subgroup is being created and click the Create New Group pictogram in this tab. To add a new group to the group structure on the Marks tab, just click the Create New Group pictogram at the toolbar of this tab. Enter the new group or subgroup name (Fig. 42) and press the Enter key on the keyboard.

In order to remove a group or subgroup, select it on the Marks tab and click the Delete Group pictogram.

In order to correct the column collection on the Marks tab, click the Column Visibility pictogram and put or remove a check mark for a proper column in its context menu (Fig. 43).

In order to change a group or subgroup name, double-click on its name in the Name column on the Marks tab and correct the name.

In order to select a marks color of the proper group, press the colored square in the Color column on the Marks tab and select the necessary color in the Select Color dialog box.

In order to select all marks of a given group, select the check box of this group in the Sel. column on the Marks tab.
In order to set a hot key for the marks of a given group, press the <key> label in the Key column on the Marks tab, then press any letter, number key or any shortcut (with Shift+, Ctrl+, Alt+) on the keyboard.

If you want or don’t want to see the marks of a given group displayed in the data window, use the sign of this group in the Vis. Marks column on the Marks tab. If you press this sign, it will turn into the following type , and the marks of the selected group will disappear from the graphics in the data window. If you press this sign again, it will turn into the following type and the marks of the selected group will appear at the graphics in the data window if they were put previously.

To add or remove the tab of a given group in the marks list located under the horizontal scroll bar of the data window, press the sign of this group in the Vis. Text column on the Marks tab. If you press this sign, it will turn into the following type , and the tab of this group will be removed from the marks list of the data window. If you press this sign again, it will turn into the following type and the tab of this group will appear in the list of the data window.
7.4.6 Marks list of the data window

All the vertical marks are included to the data window’s marks list (Fig. 44).

<table>
<thead>
<tr>
<th>Group</th>
<th>Text</th>
<th>Begin</th>
<th>End</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>M1</td>
<td>Bill</td>
<td>00:43:44</td>
<td>00:57:62</td>
<td>00:14:18</td>
</tr>
<tr>
<td>F1</td>
<td>Mary</td>
<td>00:25:57</td>
<td>00:33:90</td>
<td>00:08:33</td>
</tr>
</tbody>
</table>

Figure 44 – Marks list of the data window

Its own tab with the table of put marks corresponds to each group and contains the following information:

– the group and subgroup the mark is included in;
– the text (you can enter a comment to each mark);
– the beginning and the end of the interval;
– the interval duration;
– the indication if the mark is selected to perform some actions, for example, a playback.

The interval of a mark selected in the marks list is highlighted and selected as a highlighted fragment with the borders in the area of data displaying.
7.4.7 Marks comments

To add a text comment to a mark in the marks list, double-click the left mouse button on the **Text** cell of this mark and enter the text into the opened text window (Fig. 45).

![Text example](image)

**Figure 45 – Opened text comment window**

The text processing in the text window is the same as in any text editor. You can use the context menu (Fig. 46) and the button kit at the bottom of the window.

<table>
<thead>
<tr>
<th>Action</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl + Y</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl + X</td>
</tr>
<tr>
<td>Copy</td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl + V</td>
</tr>
<tr>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl + A</td>
</tr>
</tbody>
</table>

**Figure 46 – Text comment window’s context menu**

The purpose of each button generally repeats the context menu commands; it’s described below.

- [ ] – Undo the last action.
- [ ] – Redo the cancelled action.
- [ ] – Cut the selected text fragment.
- [ ] – Copy the selected text fragment to the clipboard.
- [ ] – Paste the selected text fragment from the clipboard.
- [ ] – Highlight with a color the selected text fragment.

Click the [✔️] button to save the comments entered in the text window.

Click the [❌] button to close the window without saving.

The comments added to marks will appear under them in the data window (Fig. 47).
Figure 47 – Example of the text comment for the interval marks
7.4.8 Export of marks to a text editor

The marks selected on the tab can be exported to a text editor. To perform it:

1) Click the button on the right bottom corner of the marks list.
2) Select with the check marks the properties you need to copy in the dialog box (Fig. 48).

![Figure 48 – Dialog box of the exported properties]

3) If you continue copying, in the next dialog box select the encoding that allows reading the copied text.

In this case, encoding is set by default. Click the OK button. The content of the selected tab will be copied to the document’s page of a text editor (copied data will be opened in a text editor that is configured in the registry by default: WordPad, Microsoft Word, Open Office) (Fig. 49).

![Figure 49 – Copied data in WordPad]
7.4.9 Copying of marks to another data window

In order to copy the put marks to another data window of the program:

1) On the Marks menu click **Copy Marks (Marks → Copy Marks)**.

2) Select the data window’s name, which marks you want to copy, from the drop-down list in the **Copy Marks** dialog box (Fig. 50).

3) Click the **OK** button to copy marks or **Cancel** button to cancel this action.

![Copy Marks To dialog box](image)

Figure 50 – "Copy Marks" dialog box
7.5 Stereo/Mono Operations

The **Stereo/Mono Operations** commands of the **Edit** menu provide an opportunity to perform the following operations with mono- and stereophonic signals:

– to divide a stereophonic signal in two monophonic ones;
– to merge (combine) two monophonic signals into a stereophonic one;
– to swap one monophonic channel with another in a stereophonic signal.

7.5.1 Dividing a stereophonic signal

In order to divide a stereophonic signal in two monophonic ones, open it in the data window and in the **Edit** menu click **Stereo/Mono Operations** and then click **Divide stereo to two mono** (**Edit → Stereo/Mono Operations → Divide stereo to two mono**).

The result of dividing a stereophonic signal in two monophonic ones (Fig. 51) can be saved in two particular files.

![Figure 51](image)

**Figure 51** – Windows of displaying the result of dividing the stereophonic signal a), b)
7.5.2 Merging of two monophonic signals to a stereophonic signal

To merge two monophonic signals to a stereophonic one, open two monophonic signals with the coinciding characteristics in the data window (Fig. 52).

On the Edit menu click Stereo/Mono Operations and then click Merge two mono to stereo (Edit $\rightarrow$ Stereo/Mono Operations $\rightarrow$ Merge two mono to stereo).

The result of merging of two monophonic signals is shown on Figure 53.
The result of merging of two monophonic signals to a stereophonic one can be saved in a particular file.

### 7.5.3 Channels’ swapping in a stereophonic signal

It’s possible to swap one monophonic channel with another in a stereophonic signal. To perform it:

1. Open a stereophonic signal in the data window.
2. On the Edit menu click **Stereo/Mono Operations** and then click **Change stereo** (Edit → Stereo/Mono Operations → Change stereo).
3. The result of the channels’ swapping can be saved in a particular file.
7.6 Signals playback

The signals playback is implemented with the Playback menu, with the proper pictograms on the toolbar and also with the keyboard shortcuts (see the Table B.1).

To play the whole signal of the active tab, use one of the methods:
1) In the Playback menu click Playback (Playback → Playback).
2) Click the ▶ Playback pictogram on the toolbar.
3) Press the F6 key on the keyboard.

To play the active tab’s signal beginning from the vertical cursor position, in the Playback menu click From Cursor (Playback → From Cursor).

To play only the selected fragment, use one of the methods:
1) In the Playback menu click Selected area (Playback → Selected area).
2) Click the ‣ Selected area pictogram on the toolbar.
3) Press Shift+F6 on the keyboard.

To play the active tab’s signal intervals chosen in the marks list, use one of the methods:
1) In the Playback menu click Intervals (Playback → Intervals).
3) Click the ‣ Intervals pictogram on the toolbar.
3) Press Alt+F6 on the keyboard.

To play the part of the active tab’s signal, which is visible in the data window, use one of the methods:
1) In the Playback menu click Visible in Window (Playback → Visible in Window).
2) Click the ▶ Visible in Window pictogram on the toolbar.
3) Press Ctrl+F6 on the keyboard.

To play all the signals opened in the active window, in the Playback menu click All Signal in Window (Playback → All Signal in Window). If there are highlighted fragments within the signals, these highlighted fragments will be played one by one. If there are selected intervals, they will be played.

To pause the playback at the position where the cursor is in the certain moment, use one of the methods:
1) In the Playback menu click Pause (Playback → Pause).
2) Click the ┃ Pause pictogram on the toolbar.
3) Press Ctrl+ P on the keyboard.

To resume the playback, repeat the actions to pause playback.

To return to the beginning of the playback, click the ━ Go to Start pictogram on the toolbar or in the Playback menu click Go to Start (Playback → Go to Start).

The playback in the program is implemented in a loop by default, i.e. when a chosen playback variant ends, it begins again.
To turn on/off this mode, use one of the methods:

1) In the **Playback** menu click **Loop (Playback → Loop)**.

2) Click the ![Loop](loop_icon.png) pictogram on the toolbar.

3) Press **Ctrl+L** on the keyboard.

To stop the playback, use one of the methods:

1) In the **Playback** menu click **Stop (Playback → Stop)**.

2) Click the ![Stop](stop_icon.png) pictogram on the toolbar.

3) Press the **Esc** key on the keyboard.

It’s possible to accelerate or slow down the playback by clicking **Playback Speed** on the **Playback** menu **(Playback → Playback Speed)** or clicking the ![Playback Speed](speed_icon.png) pictogram on the toolbar. If you repeat clicking the menu item or the pictogram, the playback speed restores to a normal. You can set the value of acceleration or deceleration in the range from 3 to 0.33, using the following methods:

1) Set this value directly in the field displaying the acceleration/deceleration coefficient (Fig. 54, pos. 1).

2) Use the scroll box, which appears when the ![sign](sign_icon.png) sign to the right of the ![Playback Speed](speed_icon.png) pictogram on the toolbar is pressed (Fig. 54, pos. 2).

While the playback is on, on the **Playback** menu click **Pseudo-stereo (Playback → Pseudo-stereo)** or click the ![Pseudo-stereo](pseudo_icon.png) pictogram on the toolbar to apply a pseudo-stereo mode (in this mode the reproduction of the same signal is repeated in another channel with the specified time lag). Repeat the actions from above to turn off the pseudo-stereo mode. You may set the time lag between the channels from 0 to 20 milliseconds using one of the following methods:

1) Set this value directly in the field displaying it (Fig. 55, pos. 1).

2) Use the scroll box, which appears when the ![sign](sign_icon.png) sign to the right of the ![Pseudo-stereo](pseudo_icon.png) pictogram on the toolbar is pressed (Fig. 55, pos. 2).

During the reproduction the current playback time is displayed in the ![field](field_icon.png) field on the toolbar.
8 DATA PROCESSING

8.1 Data editing

The data editing is implemented by using:

1) The items of the **Edit** menu (Fig. 56).

![Figure 56 – Items of the “Edit” menu](image-url)

- **Undo**: Ctrl+Z
- **Redo**: Ctrl+Y
- **Copy**...: Ctrl+C
- **Copy to New Window**...: Ctrl+Shift+C
- **Cut**...: Ctrl+X
- **Paste**...: Ctrl+V
- **Paste to New Window**...: Ctrl+Shift+N
- **Delete**...: Del
- **Shift Signal**...

**Stereo/Mono Operations**

- **Edit mode**

**Draw**
- **Erase**
- **Draw, channel: left**
- **Draw, channel: right**
- **Draw, channel: both**
- **Erase, channel: left**
- **Erase, channel: right**
- **Erase, channel: both**

- **View only**
- **Esc**
2) The items of the data window’s context menu (Fig. 57).

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open...</td>
<td>Ctrl + O</td>
</tr>
<tr>
<td>Cut...</td>
<td>Ctrl + X</td>
</tr>
<tr>
<td>Copy...</td>
<td>Ctrl + C</td>
</tr>
<tr>
<td>Copy to New Window...</td>
<td>Ctrl + Shift + C</td>
</tr>
<tr>
<td>Delete...</td>
<td>Del</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl + V</td>
</tr>
<tr>
<td>PasteMark</td>
<td></td>
</tr>
<tr>
<td>In dB</td>
<td></td>
</tr>
<tr>
<td>Vertical Auto-zoom</td>
<td>F7</td>
</tr>
<tr>
<td>Fix selected area</td>
<td></td>
</tr>
<tr>
<td>Edit mode</td>
<td></td>
</tr>
<tr>
<td>Signal Properties</td>
<td></td>
</tr>
</tbody>
</table>

Figure 57 – Data window’s context menu

3) The proper pictograms of the toolbar and the shortcuts (Appendixes B and D).

The editing commands provide performing operations of the standard functions of document editing as in the majority of the well-known applications:

- **Copy** – to copy the selected data processing area.
- **Copy to New Window** – to copy the selected data processing area to a new automatically created data window.
- **Cut** – to cut the selected data processing area.
- **Paste** – to paste to a pointed place of the active tab the data processing area, which was copied with the command **Copy** or cut with the command **Cut**. There are four variants: **After Cursor**, **To The Beginning**, **To The End**, **To New Signal** (see Fig. 60).
- **Paste to New Window** – to copy the selected data processing area, which was copied with the command **Copy** or cut with the command **Cut**, to a new automatically created data window.
- **Delete** – to delete the selected data processing area.

The **Undo** commands of the menu, the pictogram on the toolbar or pressing of Ctrl + Z on the keyboard provide undoing a done action of data editing.

The **Redo** commands of the menu, the pictogram on the toolbar or pressing of Ctrl + Y on the keyboard provide redoing an undone action of data editing.

The **Shift Signal** command provides shifting the whole signal on the horizontal scale to the left or to the right by the size of the selected fragment. Choose the shift direction in the **Segment shift** dialog box (Fig. 58).
The editing operations, which provide different processing variants, can be selected in the **Choose Processing Range** dialog box (Fig. 59). To perform processing operation, select data to process and click the **Apply** button. To cancel the operation, click the **Cancel** button.

The editing **Paste** operation is introduced with the **Paste Dialog** box (Fig. 60). To perform the command, select the insert variant and click the **Apply** button. To cancel the operation, click the **Cancel** button.

The **Edit mode** submenu provides selecting the following modes:

1. **Draw**.
2. **Erase**.
3. **View only**.
If the **Draw** mode is selected, the cursor assumes the shape of a pencil. In this mode you can press the left mouse button and move the cursor from the left to the right drawing a continuous line, which will replace the previous signal representation.

If you move the pencil to some position in the data window and click the left mouse button, the signal representation in this point will be replaced with a positive or negative peak or line, which value depends on the cursor position.

If the **Erase** mode is selected, the cursor assumes the shape of a red square. To erase a part of the signal, move the cursor to the necessary signal fragment and click the left mouse button. The part of the signal within the square’s frames will be erased, i.e. the line representing the signal amplitude will be shifted to zero within this fragment.

Use the **Draw** and **Erase** modes only to process copies of a signal, as while performing these operations, the losses in the original signal may occur.

The editing **View only** mode provides displaying and data processing in the window.
8.2 Data window’s operations

The data window’s operations are implemented with the Windows menu, the Windows tab, the toolbar pictograms and the keyboard.

To create a new window, use one of the methods:

1) In the Windows menu click New (Windows → New).

2) Click the New pictogram on the toolbar.

3) Press Ctrl+N on the keyboard.

To close the active data window, in the Windows menu click Close (Windows → Close) or press Ctrl+D on the keyboard.

To close all data windows, in the Windows menu click Close All (Windows → Close All) or press Ctrl+Shift+D on the keyboard.

To activate another data window, choose it from the opened windows’ list in the Windows menu.

The Grid mode item of the Windows menu or the Grid mode pictogram on the horizontal toolbar provide turning on/off the windows’ mode preset in the Arrange windows window.

If in the Arrange windows window the Free mode or the Grid mode were preset, then the Grid mode would be applied after pressing the Grid mode item or pictogram.

If in the Arrange windows window the Horizontal or Vertical modes were preset, then one of them would be applied after pressing the Grid mode item or pictogram.

If you repeat pressing of the Grid mode item or pictogram or change the position or size of the data window in the Horizontal or Vertical modes, the program will change it to the Free mode.

If you use the Grid mode item or pictogram, then the mode, preset in the Arrange windows window, will be applied again.

The Link Windows item, the Link Windows button on the horizontal toolbar or the F9 key on the keyboard provide linking data in windows. When one of these control elements is selected, in the data windows (except the active one) the horizontal communication and vertical communication additional margins appear (Fig. 61).
If you press these margins, then all the changes made in the active window at the horizontal or vertical scale will be replicated in all the windows where the same margins are pressed.

To break the link of a window with another one, press the proper margin in this window again.

To remove all the margins in the data window, use the Link Windows item, the Link Windows button on the horizontal toolbar or the F9 key on the keyboard again.

The Windows tab of the Manager Panel is shown on Figure 62.

The tab consists of the following elements for any data window created in the program:

1) Window name (Fig. 62, pos. 1). If you choose a window name, the window becomes active.

2) The button and the horizontal communication margin (Fig. 62, pos 2).

3) The button and the vertical communication margin (Fig. 62, pos 3).

To link the windows, press the button and hold the left mouse button pressed: the list of windows’ names will appear and any window to link can be chosen. The name of the chosen (linked) window will appear in the appropriate field on the right from the button. Click the button again to break the link.
4) The sign before the filename in each window (Fig. 62, pos 4). Pressing this sign makes the data displaying in the window enabled or disabled.

If you click the sign with the right mouse button, the Select Color window will appear (Fig. 63), where you can change the data displaying color in the appropriate window.

![Select Color window](image)

5) Data filename (Fig. 62, pos 5).

6) Data type (Fig. 62, pos 6).

7) The field of transparency grade of data displaying (Fig. 62, pos 7). This field provides defining the percentage of transparency of data displaying, when different signals cover each other in the same data window.

Press the following shortcuts:

- **Ctrl+F6** – to go to the next window;
- **Ctrl+Shift+F6** – to go to the previous window.
8.3 Data copying to the clipboard

The program provides copying of the selected screen part in the range of the data window or copying of the whole window with a signal (data) to the clipboard.

To copy a screen part:

1) In the Service menu click Copy Screen Area (Service → Copy Screen Area) or click the Copy Screen Area pictogram on the vertical toolbar.

2) The cursor will assume the shape of +.

3) Move the cursor to the necessary screen part, click the left mouse button and select the area (the area will be highlighted with another color).

4) Release the left mouse button, then the selected screen part will be pasted to the system clipboard.

5) In the Microsoft Word text editor move the cursor to the position where you want the copied screen part to be inserted.

6) In the text editor perform the Paste command, and the copied program’s screen part will be inserted as an image to the pointed place of the document.

If you click Copy Window Image in the Service menu (Service → Copy Window Image) or click the Copy Window Image pictogram on the vertical toolbar, and perform the Paste command in the text editor, then the whole active window with signals (data) will be inserted as an image to the pointed place of the document.
8.4 Getting to know the Signal Properties

To find out the properties of the signal displayed in the active tab of the data window, use one of the methods:

1) In the **File** menu click **Signal Properties (File → Signal Properties)**.
2) Click the **Signal Properties** item in the context menu of the area of data visible in the window.
3) Click the **Signal Properties** pictogram on the toolbar.

The **Signal Properties** window will appear displaying the detailed information about the signal properties depending on the signal type (Fig. 64).

Click the **Copy** button to copy the information about the signal properties to the clipboard and paste to a text editor for a report.

Click the **OK** button to close the **Signal Properties** window.

Figure 64 – Example of the Signal Properties window of an oscillogram
The program allows finding identical words in two signals opened in the editor at the same time, if user highlights the signals with the constant marks and enters those words to the comments while processing.

On the Service menu click Find Matching Words…. The Find Matching Words window will appear like the one shown on Figure 65.

Choose the matching signals from the First Signal: and Second Signal: drop-down lists in this window and click the Apply button.

The window’s workspace will be split in two columns with the names of the chosen signals on the headings. The matching comments with their proper intervals within the signal will be listed below in the columns.

If double-click the left mouse button on a found comment (word) in one of the columns, the tab containing this signal will become active, and the interval coinciding with the selected word will be highlighted as the fragment and will be displayed in the visible area of the proper data window.
10 SIGNAL’S PROCESSING

The signal's processing is implemented by using the commands of the Processing menu or the toolbar's pictograms corresponding to them.

The signal’s processing operations are applied to data in the active tab.

To start a processing, click the Apply button after having defined all the settings. To close the window of processing settings without starting a processing, press the Close button in the right top corner of the dialog box.

10.1 Amplitude normalization

The normalization is understood as the multiplication of a signal by a constant and a signal shift in each point in such manner that the amplitude maximum of a signal becomes equal to a set one, or all values of a signal get to the set interval.

Normalization can be used:
– before playback – to bring a signal to conformity with the resolution of the digital-to-analog converter or to raise a volume;
– before filtering – to reduce the rounding-off error.

To perform the amplitude normalization, on the Processing menu click Normalize... (Processing Normalize...) or click the Normalize pictogram on the horizontal toolbar.

![Amplitude normalization dialog box](image)

Figure 66 – “Amplitude normalization” dialog box

Assign the following settings in the Amplitude normalization dialog box (Fig. 66):

- By Amplitude:
  - In Counts
  - In dB
- In Interval:
  - In Counts
  - In dB
- Process:
  - Selected Area
  - Intervals
  - Visible in Window
  - Entire Signal
- All Signals in Window
- Apply
1) Select how to perform the processing in the drop-down list: **By Amplitude** (Fig. 66, a) or **In Interval** (Fig. 66, b).

2) Choose the unit of measurement of amplitude or interval: in counts or in decibels. If **In dB** is chosen, the slider’s position is set to 0 dB and this value will correspond to the maximal value 32768 in counts;

3) Assign the value of amplitude or interval in chosen units of measurement, using the slider or entering them directly from the keyboard to the **Counts** field(s).

4) Choose the area of data processing in the **Process** field:
   - Selected Area;
   - Visible in Window;
   - Intervals;
   - Entire Signal.

If there are data of several signals in the window, select the **All Signals in Window** check box to apply the assigned settings to all signals.
10.2 Amplitude changing

There are the following operations of amplitude changing in the program:

”+” – addition of a constant to a signal;

”-” – subtraction of a constant from a signal;

”*” – multiplication of a signal by a constant;

”/” – division of a signal by a constant.

To perform the amplitude changing, in the Processing menu click Change Amplitude... (Processing → Change Amplitude...) or click the Change Amplitude pictogram on the horizontal toolbar.

Assign the following settings in the Change Amplitude dialog box (Fig. 67):

1) Operation Type: addition (+), subtraction (-), multiplication (*), division (/).

2) The constant value for the chosen operation.

3) The channels for processing: Left, Right, Both.

4) Choose the area of data processing in the Process field:
   – Selected Area;
   – Visible in Window;
   – Intervals;
   – Entire Signal.

![Image of "Change Amplitude" dialog box]

Figure 67 – "Change Amplitude" dialog box

⚠️ If, while processing 16-bit signals, the constant value causes excess from the integer range (from –32768 to 32767) of the operation result in one of a signal point, the warning “Overflow” will appear in the left corner of the information line and the operation will not be implemented.
10.3 Linear transformation

If the voice volume throughout the record increases or decreases monotonously, it is possible to use the operation of linear transformation.

The linear transformation is understood as multiplication of a signal by a linear function, which is determined with two values: left and right coefficients.

To perform the linear transformation of amplitude, in the Processing menu click Transform… (Processing → Transform…).

![Transform dialog box](image)

Figure 68 – “Transform” dialog box

Assign the following settings in the Transform dialog box (Fig. 68):

1) Left Coefficient.
2) Right Coefficient.
3) Choose the area of data processing in the Process field:
   - Selected Area;
   - Visible in Window;
   - Intervals;
   - Entire Signal.

⚠️ If, while processing 16-bit signals, the constant value causes excess from the integer range (from –32768 to 32767) of the operation result in one of a signal point, the warning “Overflow” will appear in the left corner of the information line and the operation will not be implemented.
10.4 Amplitude clipping

This operation is used mostly for partial reducing of extensive pulse interferences (in those cases when there are packages of pulses, and each of them has long duration).

To perform the amplitude clipping, on the Processing menu click Clipping… (Processing → Clipping…) or click the Clipping pictogram on the horizontal toolbar.

![Amplitude clipping dialog box](image)

Figure 69 – “Amplitude clipping” dialog box

Assign the following settings in the Amplitude clipping dialog box (Fig. 69):

1) Select how to perform the processing in the drop-down list: By Amplitude (Fig. 69, a) or In Interval (Fig. 69, b).

2) Choose the unit of measurement of amplitude or interval: in counts or in decibels. If In dB is chosen, the slider’s position is set to 0 dB and this value corresponds to the maximal value 32768 in counts;

3) Assign the value of amplitude or interval in chosen units of measurement, using the slider or entering them directly from the keyboard to the Counts field(s).

4) Choose the area of data processing in the Process field:
   - Selected Area;
   - Visible in Window;
   - Intervals;
   - Entire Signal.

If there are data of several signals in the window, you can select the All Signals in Window check box to apply the assigned settings to all signals.
10.5 Resampling

This operation means changing of the sampling rate of an original signal.

Usually the sampling rate dividing is used to raise the spectral resolution in a low-frequency range. It is necessary to verify if there were overwriting and patching. In a usual voice signal with the sample rate 10 000 Hz, for instance, two separated spectral peaks can be seen with the middle power spectrum, if the distance between them is no more than 10 Hz (the frame size is 2048 counts, Hann window).

If reduce the frequency in 80 times (till 125 Hz), the peaks with the distance of 0.12 Hz can be separated. It is enough to notice how the peak of utility frequency (50-60 Hz) is duplicated and broken.

A changing of the sampling rate could be also used when the signal was recorded unsuccessfully. For a random frequency this procedure is long, but is very necessary sometimes.

In order to perform the resampling, in the Processing menu click Resample… (Processing → Resample…) or click the Resample pictogram on the horizontal toolbar.

Assign the following settings in the Resampling Settings dialog box (Fig. 70):

1) A frequency divisor for the variant Divide to integer or a new sample rate for the variant Set arbitrary. Select the arbitrary sample rate from the drop-down list or enter its value in the New Sample Rate: field.

   The spectral range spreads from 0 Hz to the middle of the sampling rate.
   During the frequency dividing the entire spectrum within the range from the middle of an old frequency to the middle of a new one will be suppressed for more than 72 dB. However, the high-frequency part of the rest spectrum (10 %) will get to the transitional area and will be distorted a little. Thus in the Bandwidth information field the maximal undistorted frequency is shown.

2) A placement of the result to the current or to a new window.
3) The necessity to create a new signal by selecting the **Create New Signal** check box.

4) Choose the area of data processing in the **Process** field:
   - Selected Area;
   - Visible in Window;
   - Entire Signal.

If there are data of several oscillograms in the window, select the **All Signals in Window** check box to apply the assigned settings to all signals.
10.6 Conversion of resolution

This operation is used to obtain a signal of a required accuracy; it is applied just for oscillograms (mono- and stereophonic).

This function provides converting a 16-bit signal to a 32-bit signal or vice versa.

For example, a low-quality signal does not need the accuracy of 32-bit; meanwhile its representation with this accuracy occupies twice as much disk space. And fine analysis operations require 32-bit accuracy on the contrary, even if the input signal representation has 16-bit accuracy. Operations with a 32-bit signal permit not to fear the overflow of the resolution and accuracy loss.

⚠️ If there is an excess of the permissible level during the signal conversion to 16-bit, then the signal will be clipped to maximum/minimum of the resolution.

To perform the accuracy conversion, in the Processing menu click Change Resolution… (Processing → Change Resolution…) or click the Change Resolution pictogram on the horizontal toolbar.

![Figure 71 – “Change Resolution” dialog box](image)

Assign the following settings in the Change Resolution dialog box (Fig. 71):

1) Choose the resolution for the signal to convert: 32 bits or 16 bits.

2) Select the Replace Source Signal check box to have only the converted signal in the data window after conversion.

3) Select the All Signals in Window check box to convert all the signals in the data window.
10.7 Speed changing

The speed changing allows obtaining a signal with the corrected reproduction speed, but with the same pitch.

It is recommended to use this function only for voice records with a relatively low frequency in comparison with the sampling rate. It is not recommended to slow down a high singing woman voice recorded with the sampling rate of 8 kHz.

⚠️ It must be considered, that the white noise decelerated in 3 times turns to a voice frequency, and a voice becomes “drunken”.

To perform the speed changing, in the Processing menu click Change Speed… (Processing → Change Speed…) or click the Change Speed pictogram on the horizontal toolbar.

![Figure 72 – “Change Speed” dialog box](image)

Assign the following settings in the Change Speed dialog box (Fig. 72):

1) The value of playback speed from 0.33 to 3 using the slider or entering it in the Value field. The value will be kept with the relative error $10^{-14}$ (if the Tempo Accuracy type was selected).

2) The type: Signal Quality or Tempo Accuracy.

Some voice fragments cannot be multiplied or deleted to maintain the high quality of output signal. If you select the Signal Quality item, such fragments will be saved. However, saving of those fragments causes the preset coefficient of the speed changing is kept inaccurately (with the accuracy about 0.01).

The speed changing varies from the preset also as the multiplied (or deleted) fragments have different lengths. If you choose Signal Quality, this effect will be corrected.

If you select the item Tempo Accuracy, then the program will maintain a precise value of the correction coefficient even to the detriment of a quality.
3) Pitch Period – an estimated pitch period in seconds. When incrementing this parameter the envelope of the output signal assumes the shape of saw and the specific overtones appear; when decreasing this parameter the clicks appear.

4) Choose the area of data processing in the Process field:
   - Selected Area;
   - Visible in Window;
   - Intervals;
   - Entire Signal.
10.8 Noise reduction

The operation of noise reduction provides removing of wideband and tonal noises from a signal.

To perform the noise reduction, in the Processing menu click Noise Suppression… (Processing → Noise Suppression…).

![Noise Reduction dialog box](image)

Assign the following settings in the Noise Reduction dialog box (Fig. 73):

1) To remove wideband noises:
   - select the Remove Wideband Noise check box;
   - choose the Max Gain in the range from 0 to 40 dB;
   - turn on/off the additional tone noise removing in the corresponding check box.

2) To remove tone noises:
   - select the Remove Tone Noise check box;
   - select the frame size in points (Auto, 256, 512, 1024 or 2048) or in milliseconds (depending on the sampling rate).

3) Choose the area of data processing in the Process field:
   - Selected Area;
   - Visible in Window;
   - Intervals;
   - Entire Signal.

To save the signal without noises as a new one, select the Create New Signal check box.
10.9 Waveform inversion

This operation is applied for oscillograms, pitch and power signals and means changing of a given signal waveform within the assigned interval to the inverted (all signal values within the interval are multiplied by – 1).

For a Fourier spectrum the operation of inversion substitutes every signal value within a given interval to 1 divided by its initial value. Thus for a visible voice representation this operation is inapplicable.

To perform the data inversion, in the Processing menu click Invert Waveform... (Processing → Invert Waveform...).

This command opens the dialog box of choosing the process range.

Choose the area of data processing in the Process field:

– Selected Area;
– Visible in Window;
– Intervals;
– Entire Signal.

Then click the Apply button to start processing or click the Cancel button to cancel the operation.
10.10 Modulation

The modulation mode is a dot-by-dot multiplication of two signals with floating normalization of the result. For this operation, 16- or 24-bit oscillograms, recorded in monophonic mode and having equal sampling rate, can be used.

To perform the signal modulation, in the Processing menu click Modulation… (Processing → Modulation…).

In the Modulation dialog box (Fig. 74):

1) Choose the area of data processing in the Process field:
   - Selected Area;
   - Visible in Window;
   - Intervals;
   - Entire Signal.
2) Select a signal to be modulated from the drop-down list.
10.11 Mixing

The mixing is necessary in case of sound effects generation for test signals formation (e.g. a voice signal with the interference of a certain type). The mixing means composition of the appropriate counts of a first and a second signal and recording of the obtained results. Only the signals situated in the same window can be mixed.

To perform mixing, in the **Processing** menu click **Mixing...** (**Processing → Mixing...**) or click the **Mixing** pictogram on the horizontal toolbar.

![Mixing dialog box](image)

In the **Mixing** dialog box (Fig. 75), assign the parameters of mixing of the particular signals:

1. Select the signals' names in the **Signal Name** drop-down list.
2. Set the level of every mixed signal with the **Weight** sliders.
3. Add or remove a signal selected in the **Signal Name** drop-down list to/from the summary signal with the + or - buttons respectively.
4. Enter the summary signal name in the **Signal Name** field.
5. Set the amplitude of the summary signal with the **Amplitude** slider.
6. Select the accuracy of the signal in the **Bits per Count** drop-down list: 16 or 32 bits.
7. Select the sample rate of the summary signal from the **Sample Rate** drop-down list.
8. In the **Result in** drop-down list select in which window you would like to see the result of mixing.

Click the **OK** button to perform the mixing operation; or click the **Cancel** button to cancel it.
**10.12 Filter applying**

The principal function of this operation is displaying and correction of the sound signal spectrum, being achieved first of all with using the inverse filtration and the filter contrasting.

The filters can be applied to reduce randomly appeared stationary components in a sound signal, and also the amplitude’s decays or amplifications in some spectral lines. The examples of this type of signals are the sound records that contain considerable stationary interferences such as power inductions, noises from mechanisms and engines, etc.

A filter could be applied only if it was previously created and saved as it is explained in the section 11.3.3 of this manual. In order to apply a filter, perform the following actions:

1) In the **Analysis** menu click **Spectrum (Analysis → Spectrum)**.

2) Click the **Presets** button in the **Spectrum** window and choose a previously saved filter in the context menu (if it was saved) (Fig. 76).

3) The filter’s frequency characteristic will be displayed in the **Spectrum** widow with the spectrum curve (Fig. 77).
Figure 77 – “Spectrum” window (the spectrum is displayed as the white curve; the frequency characteristic is displayed as the lilac-colored curve)

4) Choose the tab with the signal, to which you want to apply a chosen filter, in the data window.

5) In the **Processing** menu **click Apply Filter...** (*Processing* → **Apply Filter...*) item that has become active.

6) In the **Apply FFT Filter** dialog box (Fig. 78):
   - select a channel to process in the corresponding drop-down list;
   - select the area of data processing: Selected Area, Visible in Window, Intervals, Entire Signal;
   - select in the **Result to** drop-down list, in which window you would like to see the result of the operation;
   - select the **Create New Signal** check box, if it is necessary to create a new signal.
   - click the **Apply** button to apply the filter, or click the **Close** button in the right top corner of the dialog box to close the window.
7) If it is necessary, repeat the paragraphs 4–6 for the other signals.
10.13 DirectShow filters

10.13.1 Applying the filters

The DirectShow filters are the common multimedia processing interface, supported by the majority of the programming languages. Besides, DirectShow is able to be extended and supports devices, formats and processing components of third-party manufacturers.

Using DirectShow the program provides using the **Sound Cleaner** signal processing plug-in produced by STC or any other software products supporting this interface.

To apply the DirectShow filters, in the **Processing** menu click **DirectShow Filters…** (Processing → DirectShow Filters…) or click the **DirectShow Filters** pictogram on the horizontal toolbar.

In the **DirectShow Filters** dialog box (Fig. 79):

1) Select a signal to be processed in the drop-down list.

2) Select the area of data processing:
   - **Entire Signal**;
   - **Selected Area**;
   - **Visible in Window**.

3) Choose the filter (clicking a check mark in the **Use** column for the corresponding list’s row).

4) If you want the current signal to be replaced with the filtered one, select the **Replace original segment** check box.

5) If you want to listen to the result of applying of the chosen filter, select the **With playback** check box.

To perform a preview, click the **Preview** button.

To perform the processing, click the **Process** button.

To close the dialog box without performing an operation, click **Close** button.
10.13.2 Editing of the filters collection

To edit the DirectShow filters collection, in the Processing menu click DirectShow Filters… (Processing → DirectShow Filters…) or click the DirectShow Filters pictogram on the horizontal toolbar. The DirectShow Filters dialog box will be opened (see Fig. 79).

To add a filter:

1) Click the Add Filter button.

2) Choose a necessary filter in the Choose filter to add... window and click the OK button (Fig. 80).

3) The chosen filter will be added to the list of the DirectShow Filters dialog box.

If a filter has some extra configurations, then the Configure button will be situated in the Options column of this filter’s row.

To remove a filter from the list, click the Remove button in the Remove column of this filter’s row.
11 SIGNAL ANALYSIS

11.1 Operation with the analysis dialog box

Signal analysis is performed by using commands of the Analysis menu or toolbar icons.

While constructing FFT, LPC spectrograms, cepstrum or autocorrelation, dialog boxes for analysis settings and signal visualization appear on the left side of the main window. They are attached to the vertical toolbar. The spectrum construction window appears in the right side of the central workspace of the main window and it’s attached to the control panel.

Thus data windows are changing its scale, leaving space for dialog boxes, which set analysis parameters. When closing windows with the analysis parameters or moving them outside the main working window, data windows take previous size.

To close the dialog boxes of spectrums, FFT, LPC spectrograms, cepstrum or autocorrelation constructions, click the button in the upper right corner of the window or press the Spectrum, 3d FFT, 3d LPC, Cepstrum or Autocorr. buttons on the vertical toolbar.

To separate the spectrums, FFT, LPC spectrograms, cepstrum or autocorrelation construction windows from the main window, click the button in the upper right corner of the window.

To return the windows on a former place in the main window, double-click the left mouse button on the window title.

![Figure 81 – Independent analysis dialog box](image)

In dialog boxes of the FFT, LPC spectrograms, cepstrum or autocorrelation constructions, specific fields (spectrogram, cepstrum, autocorrelation, 3d LPC, normalization, visualization) can be collapsed or expanded by clicking the left mouse button on their title.

The composition of the normalization parameters and visualization settings, which is the same for all types of the analysis, is described below.

To expand the Normalization field (Fig. 82), click the left mouse button on its name.
In the **Normalization** field specify:

1) The frequency of the ascending beginning in hertz.
2) The rate of the ascending in dB per octave.

These parameters set the frequency from which the ascending of the amplitude spectrum and the rate of the ascending start.

For instance, the ascending from the frequency 200 Hz to 6 dB/Oct means spectrogram’s amplitude increasing on 6 dB on the 400 Hz frequency in comparison with 200 Hz, etc.

By varying the ascending of the spectrum, you can get the most visual spectral picture at high frequencies. The optimal value of the amplitude ascending is set by the cut-and-try method for a specific signal.

3) The Normalization option on the maximum amplitude of the cut: None, Entire signal, Higher than level only.
4) The value of the signal level from maximum percent, beyond which the signal must be normalized (for normalization option Higher than level only).
5) Consider or not the null component (select the check box). If the mode is enabled, then the filtration is carried out in view of the constant component.

6) The button enables to choose the ready-made parameters profiles (Fig. 83):

To open the **Visualization** field (Fig 84), click the left mouse button on it.
In the **Visualization** field specify:

1) **Visualization Type**: **Grayscale, Right deviation, Color**.

When imaging in color, certain numerical intervals of values are associated with one of the colors. In the ascending order of signal values, colors change in the following order: black, tints of green (from dark to light) turning into yellow, yellow-brown, brown, purple, and white. The order of colors is taken by analogy with a map.

Grayscale image can be viewed as a special case of image with color. The greater the magnitude of the signal, the darker tint it matches.

When drawing a “deviation to the right” the time axis corresponds to the X-axis and the frequency axis – the axis Y. The principle map is a logical image of each cut with its diagram of the frequency function. In this the imaginary frequency axis of each cut passes through the middle frame of the current cut along the time axis and it’s perpendicular to the axis of time.

The Z-axis as it coincides with the time axis. A sufficiently large scale of image in the window is the best way that allows making out each cut.

The advantage of the deviation to the right over the types of image with color and the gray scale is that this type shows the most dynamic range.

The dynamic range in presenting the color or the gray scale is limited with the display ability to image, and the user – to distinguish between tints of color.

However, the deviation may not accurately link the position of the maxima in the spectrum with the waveform for the fast variables in the spectrum of signals, so if it’s important to track the position of a spectral maximum over time it is better to use the “tint” image.

Color makes it easier to allocate low amplitude maxima in the very noisy spectrum as compared with the tints of gray.
2) Palette (there are 2 types of palettes for Color Visualizing).

3) Brightness. By default the brightness is equal to 1 that corresponds to the middle position. The increasing of the brightness augments the signal amplitude; the decreasing of the brightness reduces it.

4) The contrast between 0 and 1. The default setting is the maximum value of 1.

5) The scale of the third dimension: Linear, Logarithm.

6) The dynamic range.

Options 5 and 6 enable to display the amplitude in a logarithmic scale. In this case, the value of the amplitude is converted initially to decibels, and only then it’s displayed.

The value of the expected maximum is equal to the value of the dynamic range, and on this basis, all other values are recalculated.

The upper limit of color levels are also set equal to the dynamic range, and the upper part of the signal might not be showed. This occurs when the value of the dynamic range, taken as the maximum in fact turns out to be considerably less than the real maximum.

7) The lower frequency limit.

8) The upper frequency limit.

The last two parameters allow you to specify the frequency band in the spectrogram image.

After setting all the options in dialog boxes of FFT, LPC spectrograms, cepstrum or autocorrelation constructions (see Fig. 81), in the drop-down list select the window where the result will be launched and run the analysis process by clicking the **Apply** button.

The analysis process takes time; it’s displayed in the window.

To be able to change some settings in the windows of FFT, LPC spectrograms, cepstrum or autocorrelation constructions, select the **Auto apply settings** check box. The constructed before image will be redrawn immediately when it’s chosen a new value from the drop-down list, or when you specify a new number and press the **Enter** button on your keyboard.
11.2 Weighting windows

This section describes the weighting windows; their usage is common to all of the Fourier spectra.

11.2.1 Theoretical reasoning for the use of windows

The decomposition of signals on the basis of sines and cosines (Fourier transformation) is valid only for signals of the infinite duration. However, as the real signals are finite in time, and moreover, in most situations, you need to know how to change the spectral properties of the signal from one instant to another, in the calculation of the signal spectrum they use finite segments of the signal.

Analysis of the final segment of the signal corresponds to the use of an infinite signal multiplied by a rectangular function which is equal to the unity in this interval and zero outside this interval. Such process is called “multiplication by the window”, or weighing, and the function which multiplies the signal is called the weighting (window) function, or “window”.

Since the ends of the cut, by rectangular window, signal at the boundary of the analysis interval can be stopped suddenly; a similar fact in this case may lead to distortion of the spectrum structure, giving the surges of the spectral amplitudes associated with no signal, and with the placement and shape of the window. To reduce this effect the rule is to smooth the ends of the signal in the range of analysis, that is, to use the box function with the decline of values to the ends from the middle of the window.

In the spectral region the use of these windows leads to a smoothing of the estimates of the spectrum and the elimination of these surges of amplitudes, although there is some deterioration in the accuracy of the spectral resolution.

The use of the analysis window in the time domain corresponds to the convolution of the signal spectrum with the spectrum of the analysis window in the spectral range. Particularly, the use of “no” (rectangular) analysis window corresponds to the convolution of the signal spectrum with the spectrum of a rectangular function (also known as the Dirichlet kernel). Due to this convolution, “window” effects occur that cause smoothing of the spectra of closely located signals and emphasize the influence of distant in frequency, but high-power noise.

In the spectrum of each window function it’s the rule to distinguish between the main spectral lobe and side - in fact spurious, additional lobes, which degrade the initial spectral estimates, affecting the value of each spectrum. Moreover, if the side lobes have large amplitude, the effect on a given spectral counting even of distant spectral samples can be significant.

To reduce the amplitude of the lateral spectral lobes of the window function is only possible by extending the main lobe, i.e., by lowering the accuracy of the spectral resolution.

The choice of the analysis window is used to control the effects due to the presence of side lobes in the spectral estimates. The minimum width of the spectral peaks, weighted by the sequence window, is limited to width determined by the main lobe of the conversion of this window, and does not depend on the initial data.

Side lobes of the window conversion, sometimes called leakage, will change the amplitude of adjacent spectral peaks. Since the discrete-time Fourier transformation is a periodic function, then the superposition of the side lobes from adjacent spectral periods can lead to an additional shift of the spectral peaks in frequency.
Leakage leads not only to the emergence of the amplitude errors in the spectra of digital signals, but can also mask the presence of the weak signals against the background of strong ones (weak in amplitude formants on the background of strong ones), and therefore, it can impede their detection.

It can be offered a number of window functions, the use of which allows reducing the side lobe level, compared to that level that they have in the case of a rectangular window (not the weighting windows). Reduction of the side lobes will reduce the shift of the spectral estimates. However, it is achieved due to the expansion of the main lobe of the spectrum window, which naturally leads to a deterioration of resolution. Therefore, a compromise between the width of the main lobe and the level of suppression of the side lobes should be chosen.

For the classification of window functions several indicators to assess their quality are used.

The bandwidth of the main lobe gives an indication of the frequency resolution.

For the quantitative evaluation of the bandwidth of the main lobe two indicators are used. The traditional measure is the bandwidth at half power level, i.e., at a level that at 3 dB below the maximum of the main lobe. As a second measure, the equivalent bandwidth is used.

Two indicators are used for evaluation of the characteristics of the side lobes. One of them is the peak (or maximum) side-lobe level, which gives an indication of how well a window suppresses the leakage.

The second one is the rate of falling of the level of the side lobes, which characterizes the rate at which the side-lobe level decreases, next to the main lobe. In essence, the rate of falling of the side lobes depends on the number of used samples N and with increasing N, and tends to an asymptotic value, which is usually expressed in decibels per octave of change of bandwidth of frequencies.
11.2.2 Description of the five main windows

Below are the definitions of the five most commonly used discrete-time window functions from the number of proposed at various times for use in spectral estimation.

"HANN" - Hann’s window - (i=0..N-1)
\[ \text{SIGNAL}[i] = \text{SIGNAL}[i] \times (0.5-0.5 \times \cos \left(\frac{2 \times \pi}{N} \times i\right)) \]

"HAMMING" - Hamming’s window - (i=0..N-1)
\[ \text{SIGNAL}[i] = \text{SIGNAL}[i] \times (0.54-0.46 \times \cos \left(\frac{2 \times \pi}{N} \times i\right)) \]

"NUTTALL" - Nuttall’s window - (i=0..N-1)
\[ \text{ARG} := \frac{(i-(N-1)/2)}{(N-1)}; \]
\[ \text{SIGNAL}[i] = \text{SIGNAL}[i] \times (0.3635819 + 0.4891775 \times \cos \left(\frac{2 \times \pi \times \text{ARG}}{N}\right) + 0.1365995 \times \cos \left(\frac{4 \times \pi \times \text{ARG}}{N}\right) + 0.0106411 \times \cos \left(\frac{6 \times \pi \times \text{ARG}}{N}\right)) \]

"GAUSS" - Gaussian window, i=0, ..., N-1, \[ \text{ARG} = \frac{(i-N/12)}{N} \times 8 \]
\[ \text{SIGNAL}[i] = \text{SIGNAL}[i] \times \exp \left(-\ln(2) \times \text{ARG} \times \text{ARG}\right) \times 2.51 \]

"RECTANGLE" - rectangular window (no window) - the signal without changes.

Characteristics of windows:

<table>
<thead>
<tr>
<th>Window</th>
<th>Rectangular (no)</th>
<th>Hamming</th>
<th>Hann</th>
<th>Nuttall</th>
<th>Gauss</th>
</tr>
</thead>
<tbody>
<tr>
<td>The maximum side lobe level (dB)</td>
<td>-13.3</td>
<td>-43</td>
<td>-31.5</td>
<td>-98</td>
<td>-115</td>
</tr>
<tr>
<td>Asymptotic rate of falling of the side lobes (dB / oct)</td>
<td>-6</td>
<td>-6</td>
<td>-18</td>
<td>-6</td>
<td>(-139)*</td>
</tr>
<tr>
<td>The equivalent bandwidth</td>
<td>1.00</td>
<td>1.36</td>
<td>1.50</td>
<td>1.80</td>
<td>3.50</td>
</tr>
<tr>
<td>The bandwidth at half power level</td>
<td>0.89</td>
<td>1.30</td>
<td>1.44</td>
<td>1.70</td>
<td>3.0</td>
</tr>
</tbody>
</table>

* - For 16-bit and 24-bit signals Gaussian windows of different widths are used, so the side-lobe level for 24-bit signals is (-139) dB.

Of all the windows given in the table is the narrowest main lobe has a frequency response of a rectangular window, but it has the highest level of side lobes. The side lobes of Gaussian window in logarithmic scale don't tend to a straight line, but fall off much faster than any of these windows.

The “cosine squared” window is named after the Austrian meteorologist Julius von Hannah. This window is often mistakenly called Hanning’s window.

The Raised cosine curve window was introduced by R. W. Hamming, and so it’s often called by his name. Multipliers 0.54 and 0.46 were chosen in order to eliminate the maximum side lobe entirely.
11.2.3 An equal period moving window

In some types of the analysis, the program uses the so-called equal period moving window. Different number of periods of the function (the characteristic in calculating of the harmonics of amplitudes) take part in calculating the normal spectrum, and related to it functions. If the spectrum with the window of 256 is calculated, a first harmonic with a period of 256 is placed in the analysis window of 1 time, and the last harmonic with the period of 2 is placed in the window of 128 times. As a result, the high-frequency harmonics (with low periods) are significantly averaged and the low-frequency ones are not.

For an equal period moving window the auto covariance function is calculated so that the width of the analysis window with the decreasing frequency increases to compensate for the above effect. Spectrum, cepstrum and autocorrelation are calculated later through this auto covariance function.

The width of the analysis window increases linearly with the time-harmonic growth (a period inversely proportional to frequency), not exceeding the value of the frame size.

11.2.4 Recommendations on the choice of the type of window

The choice of window is conditioned by a compromise between the distortion of the spectrum in the near side lobes (blurring of the spectrum) and the distortion due to the influence of the distant side lobes (the appearance of spurious emissions).

For example, if the sufficiently strong signal components are located close to/away from the weak components of the signal, then for their analysis, the window should be chosen with the same level of side lobes around the main lobe, in order to provide a small shift of the spectral peaks.

If there is a strong component, remote from the weak component of a signal, you should select a window with the rapidly falling side lobes, and in this case their level in close proximity to the main lobe does not really matter.

If it is necessary to provide high resolution between the near components of the signal, (the remote components are missing) the box with the increasing level of the side lobes (but with a very narrow main lobe) may be appropriate.

If the dynamic signal range is limited, then the characteristics of the side lobes do not really matter.

If the spectrum of the signal is relatively smooth, it is possible not to apply the window.

To obtain more visible image of the signal it's recommended to choose one of the first three boxes. They are arranged in decreasing order of the side lobes level of the spectral characteristics of the window and in increasing order of the width of the main spectral lobe. The effective width of the window, compared with a rectangular, decreases in 1.36, 1.5, 1.8 and 3.5 times.
11.3 Spectrum

Spectral analysis is a method of signal processing that allows characterizing the frequency content of the signal. The most popular method of the spectral analysis is the harmonic analysis, in which the temporal signal is related to its representation in the frequency domain with Fourier transformation.

11.3.1 Using Spectrum’s window

To open the Spectrum dialog box (Fig. 85) on the Analysis menu, click Spectrum (Analysis → Spectrum) or click the Spectrum button on the vertical toolbar or press Ctrl+Q.

In this window, for the spectrum construction, the Selected Area, data In point, Entire Signal options of the active tab can be used. When selecting the appropriate option in the Process field, the spectrum is rebuilt.

If you select Entire Signal, medium spectrum FFT (Fast Fourier Transformation) is constructed. When calculating the average of the signal spectrum, an accumulation of the spectra occurs, calculated in some areas of the signal. This can be summarized as follows. Signal is superimposed with the window of the size that corresponds to the
set frame size. On the signal sample, which came to the window, the spectrum is calculated. Then the window is shifted by a given step and the spectrum is calculated on the next sample. So there is an accumulation of the spectra around the signal and an average spectrum is calculated.

If you choose the **In point** option, then, setting the cursor to the right location data, you can consistently perform analysis of the FFT instantaneous spectrum with the given analysis parameters.

If you choose the **Selected Area** option, then, separating the different pieces of data, you can view the average spectra of these fragments.

The transition from point to point or changes of the selected fragment does not require the reopen the “Spectrum” window. The new spectrum is displayed on the site of the previous one. You can save up to five previously constructed spectra, if press the buttons in the **Stored:** field. The spectra will be superimposed on each other, and each of them will be displayed with an individual color (Fig. 86).

![Figure 86 – Example of preservation of the spectra of five different points of the signal](image-url)
Repeat pressing the **Stored**: button removes corresponding to it graphical representation of spectrum forever.

For stereo signals while constructing the spectra it’s possible to select the channel with the **L** and **R** buttons. The spectrum is constructed in the coordinates: “the level in decibels - the frequency in hertz.”

The step of each scale can be changed while placing the cursor on it and rotating the mouse wheel.

At the same time, to move the display data area on the frequency, horizontal scroll bar becomes active (Fig. 87).

The use of the mouse wheel and the horizontal scroll bar is similar to that of the data window (for more info, please refer to the points 7.3.4 and 7.3.5 of the manual).

To return quickly to the display of the full spectrum, press the **Fit entire signal to preview area** button in the “Spectrum” window.
11.3.2 Modifying spectrum’s construction

To change the settings of the spectrum construction, click the button on the right of the horizontal scroll bar.

Beneath the Process area it’s possible to change the following settings (Fig. 88):

1) In the Frame size area, choose the frame size in points or ms.

Depending on the frame size, narrowband or broadband spectrum can be received. On the narrow-band spectrum, the spectral picture is more detailed, and on the broadband spectrum - more common.

To obtain a narrow-band spectrum, the frame size must exceed the maximum period of pitch. In this case, for the male voice, the frame size is 256 counts and more, for the female voice - 128 counts or more.

To obtain a broadband spectrum, the frame size must be less than the maximum period of pitch. 64 counts are for the male voice, 32 counts are for the female one.

2) In the Step area, specify the frame size in points or ms.

The step of frame shift determines the value by which the window is shifted according to the signal. When selecting the step of the frame shift, which is greater than the frame size, not all points of the signal will be
involved in the process of calculation. To set the step shift within 1/4 - 1/2 of the size of the frame analysis is the optimum. By default, when you select the frame size, the step is set automatically, equal one quarter of its value.

3) In the **Weight and mean** area, choose the type of the weighting window: **Hamming**, **Hann**, **Nuttall**, **Rect**, **EquPeriod**, **Gauss**.

To obtain more graphic image of the signal it’s recommended to choose one of the first three boxes. They are arranged in decreasing order of the side lobes of the spectral characteristics of the window and in increasing order of the width of the main spectral lobe in the following order: Hamming, Hann, Nuttall. The effective width of the window, compared with a rectangular, decreases in 1.36, 1.5 and 1.8 times.

In order geometric mean is calculated, while averaging the spectrum; select the **Geometric mean** check box.

4) In the **Skip pauses** area, select the check box and specify amplitude pauses in counts.

In this case, parts of the signal with amplitude of less than specified will not be taken into account.

5) In the **Normalization** area, select the check box and specify normalization level in counts.

In this case, before performing the calculations the chosen area of signal processing will be normalized to given amplitude.

Change of any parameter of the spectrum construction leads to the automatic renewal of the spectrum image in view of the change.
11.3.3 Creating of the on-site filters

Parameters of the spectrum calculation can be used when creating your own filters. To do this:

1) Right-click on the image of the spectrum and in the context menu, select one of the filter (Fig. 89).

   ![Figure 89 – Variants of filters](image)

2) Frequency characteristic of the selected filter is displayed in the image of the spectrum (Fig. 90).

   ![Figure 90 – Frequency filter characteristic](image)

3) In the context menu of the graphic image of the spectrum the **Draw** and **Erase** items will be available (Fig. 91).

   The use of these items allows you to adjust manually the frequency response of generating filter.

   To exit from the editing or erasing, right click on the image of the spectrum and then click **View only**.

   ![Figure 91 – Context menu with the available items “Draw” and “Erase”](image)

4) To save the received frequency characteristic of the filter, click **Presets** and in the context menu select the **Save current filter...** item.

5) In the dialog box «Preset saving» (Fig. 92) input the **Preset name:** and click **OK**.

   To cancel the saving of filter, click the **Cancel** button.

   ![Figure 92 – “Preset saving” dialog box](image)
11.3.4 Using ready-made profiles

While constructing spectrums, processing filters (some of them are in the program and some - generated by the operator) can be used. To use a saved profile filter, click the **Presets** and use the appropriate context menu item (Fig. 93).

![Presets button and context menu](image)

**Figure 93 – Context menu of the “Presets” button**

The button **Presets** allows choosing one of the ready-made profiles:

1. **Formants** (Fig. 94)

![Formants profile selection](image)

**Figure 94 – Choice of the profile “Formants”**

- Tenor (130 - 520 Hz)
- Baritone (110 - 390 Hz)
- Bass (80 - 350 Hz)
- Profound Bass (50 - 220 Hz)

2. **Broadband** (Fig. 95)

![Broadband profile selection](image)

**Figure 95 – Choice of the profile “Broadband”**
3. Harmonics (Fig. 96)

<table>
<thead>
<tr>
<th>Presets</th>
<th>Formants</th>
<th>Broadband</th>
<th>Harmonics</th>
<th>Tone harmonics</th>
<th>Technical harmonics</th>
<th>High fundamental frequency (&gt;220 Hz)</th>
<th>Low fundamental frequency (&lt;220 Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical harmonics</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Maximal resolution</td>
<td>Medium resolution</td>
</tr>
</tbody>
</table>

Figure 96 – Choice of the profile “Harmonics”
11.4 FFT Spectrogram

To characterize any complex sound acoustically it is necessary to have the pitch data, the frequency of the pitch harmonics and the relative intensities of all its frequency components i.e., how the pitch and the harmonics refer to each other in intensity. These data can be obtained by spectral analysis of sound.

Spectrogram FFT allows us to see a continuous picture of the changes in the spectral characteristics of the sound segments of different duration.

11.4.1 Choice of calculation settings

To open the 3d FFT Spectrogram dialog box, on the Analysis menu, click 3d FFT… (Analysis → 3d FFT…) or click the 3d FFT button on the vertical toolbar.

![Spectrum field](image)

In the Spectrogram field (Fig. 97), specify:

1) Frame size in points or ms. Depending on the size of the window (frame) it’s possible to obtain a narrowband or broadband spectrum. On the narrow-band spectrum, the spectral picture is more detailed, and on the broadband spectrum - more common.

To obtain a narrow-band spectrum, the frame size must exceed the maximum period of the pitch. In this case, for the male voice, the frame size is 256 counts and more, for the female voice - 128 counts or more.

To obtain a broadband spectrum, the frame size must be less than the maximum period of the pitch. For the male voice, the frame size is 64 counts; for the female - 32 counts.

2) The step size in points or ms. The step of frame shift determines the value by which the window is shifted according to the signal. When selecting the step of the frame shift, which is greater than the frame size, not all points of the signal will be involved in the process of calculation.

To set the step shift within 1/4 - 1/2 of the size of the frame analysis is the optimum.

3) The type of the weighting window: Hamming, Hann, Nuttall, Rect, EquPeriod, Gauss.
To obtain more graphic image of the signal it’s recommended to choose one of the first three boxes. They are arranged in decreasing order of the side lobes of the spectral characteristics of the window and in increasing order of the width of the main spectral lobe.

4) The amount of points of the smoothing filter from 0 to 55 points.

When operating with the filter, geometric averaging of the image according to the selected number of points is performed. The averaging is carried out to get more detailed picture of formants and to smooth the tone's harmonic. If you need to see some harmonic, averaging is not performed (the number of points of a smoothing filter is 0).

5) Data processing area: **Selected Area, Visible in Window, Entire Signal**.

6) The button allows choosing one of the ready-made profiles:

1. Formants (Fig. 98)

2. Broadband (Fig. 99)

3. Harmonics (Fig. 100)
Other parameters are described in Section 10.1 of this manual.
11.4.2 Calculation’s results

After completing the calculations, FFT spectrogram will appear in the selected data window (Fig. 101).

To research the FFT spectrogram, all means of the data window are available; please refer to Section 7.3 of this manual.

The image of the spectrogram in the data window can be optimized by means of visual customization. To do this, use one of the following methods:

1) In the context menu of the main window, click **Visualization Settings**.

2) On the **Service** menu, click **Visualization Settings (Service → Visualization Settings)**.

3) Click **Visualization Settings** on the vertical toolbar.

In the window that displays the spectrogram (Fig. 102), a cross, an additional scale above the data and two sliders below the horizontal scale will appear.

The initial position of a cross corresponds to the given in the **Normalization** field values:

- Frequencies of the beginning of upsurge (frequency values are displayed on the vertical scale of the data window);
- Values of upsurge in decibels per octave (an additional scale of the data).

To change these values:
1) Move your mouse over a cross.
2) Press the left mouse button.
3) Move the cross to the place, corresponding to new values of the frequency and upsurge (based on the vertical and additional scale).
4) Release the left mouse button.

Displayed in the window, data of FFT spectrogram will be redrawn according to new values of the frequency of early upsurge and upsurge values.

The left slider changes the brightness value, specified in the **Visualization Settings** field, and the right slider - the contrast. Operative selection of these values also allows achieving optimal data representation of spectrogram.

To remove the elements of visual customization, re-click ☀️ **Visualization Settings** on the vertical toolbar.

If select the **Auto apply settings** check box in the dialog box of FFT spectrogram construction, then to optimize the image it’ll be possible to use changes of any parameters of the window.

The image, built before, will be redrawn immediately when choosing a new value from the drop-down list or when presetting a new number and clicking **Enter** on your keyboard.
Linear prediction of speech is one of the most effective methods for analysis of speech signal. It allows estimating the basic parameters of the speech - the period of the pitch, formants of the spectrum, and the parameters of the vocal tract. The effectiveness of this method is determined by the degree of speech signal compliance with the selected pole model, describing the transmission function of the vocal tract.

The basic idea of linear prediction is that the value of each current sample of speech signal can be approximated as a linear combination of previous samples. The order of linear prediction model is called the number of previous samples, needed to restore the current sample. The coefficients, with which the values of the samples are weighted, are called the coefficients of linear prediction (LPC).

The spectrum analysis according to the linear prediction coefficients is as follows. LPC are calculated by the Levinson-Durbin algorithm, and the autocorrelation coefficients are calculated at the temporal window, size of which should be not less than the number of coefficients and no more than 1024. The speech signal is weighted in this window with a function (which one - depends on the choice of type of the weighting window).

After the LPC coefficients are defined, we construct a sequence in which the LPC are the first m +1 members (m – the order of the pole model), and the rest - zeroes.

Sequence length is selected according to the required frequency resolution (at the sampling frequency of 10 kHz and the resolution no less than 30 Hz length N> = 10000/30; choosing the nearest degree of 2 greater than N, we obtain the length of the sequence).

Having calculated the FFT of the sequence and taken from it a reciprocal, we obtain a smoothed spectrum of the speech signal, in which maximum is searched. This type of spectral representation of the speech signal allows us to see formant structure more clearly in comparison with the conventional analysis.

When using a linear prediction it’s required to monitor the compliance of the envelope of the spectrum, obtained by using the model representation of the signal, with the actual spectrum of the signal. If the signal can be in pole description, and the model order is chosen correctly, then the constructed frequency response gives a description of the spectrum with higher accuracy (spectral resolution) than it can be obtained using common spectral description (by computing the Fourier transformation).

In case the analyzed speech signal is in conformity with a linear prediction model, LPC analysis makes it possible with a high degree of spectral resolution to estimate the formants and their widths, as well to construct a spectral envelope of the spectrum, excepting from it the fine structure.

Thus, according to the LPC analysis, the visual speech can be build and the segmentation of speech signals can be performed (sometimes even more successfully than according to the spectrogram).
11.5.1 Material preparation

To build successfully the LPC spectrogram (frequency response) it’s necessary to perform the following preparatory steps with the initial material:

1) Remove fragments of speech signal containing speech and non-speech interference.

2) If necessary, conduct Noise reduction.

3) Perform the normalization of each replica on the amplitude 32000-32767 counts.

   It is undesirable to use for the analysis, the signals whose amplitude is less than 256 counts.

4) To calculate, for the initial material, the FFT dynamic spectrogram.

   According to it, if it is possible, the number of formants is defined for the exploring fragment of signal, which will be used when setting the calculating parameters of the frequency response of LPC. In addition, the image of the spectrogram is used to control the correctness of the image of the LPC spectrogram.
11.5.2 Choice of calculation parameters

To open the dialog box of the LPC spectrogram construction, on the Analysis menu, click 3d LPC ... (Analysis → 3d LPC ...) or click the 3d LPC button on the vertical toolbar.

![3D LPC dialog box](image)

In the 3d LPC field (Fig. 103), specify:

1) Frame size in points – the required duration of the frame of the signal analysis in counts. Generally LPC is calculated in the interval of 20 - 30 ms (corresponding to 200 - 300 counts at the sampling rate 10000 Hz).

It is believed that this is the optimal length, corresponding to the rate of change of the spectral envelope of the speech signal.

If the rate of the pronouncing of a verbal communication is very high, it makes sense to reduce the length of the window. Probably, it’s often advisable to use a frame size of 2 - 5 ms (this corresponds to 20 - 50 counts at the sampling rate of 10,000 Hz), which allows observing the structure of formants of the spectrum within periods of the pitch of speech.

2) Frame size in points or ms – the value on which the frame (window) of analysis is shifted in time by a signal. The shift step is given so that the segments of the speech signal, on which LPC is calculated, are overlaid, i.e. the shift step of the frame must be less than the frame size. Usually, the optimal step is 1 / 8 - 1 / 2 size of the frame analysis. When selecting from the drop down list the frame size, the step size is automatically set in the program (1 / 4 size of the frame analysis).

3) The type of the weighting window: Hamming, Hann, Nuttall, Rect, EquPeriod, Gauss.

Weighing window is used to reduce the prediction error at the ends of the interval. Temporary window should reduce the values of the signal at the ends of the interval to zero. Usually Hamming’s window is used for this purpose.

4) The amount of LPC coefficients – value that determine the order of model.
In practice, to determine the order of model, dynamic spectrogram is calculated, and the number of formants is set. Model order is equal to doubled number of formants. Usually in the range of 5 kHz the number formants is equal to 6 or 7, then the number of coefficients of LPC should be 12 - 14. Reducing the number of coefficients can cause an error. If specify the number of coefficients of LPC equal to 8, then there will be only a maximum of four spectral peaks on the image, if we have really four, the position of these four spectral peaks on the image of frequency response of LPC will correspond with reality. If the actual formant number is not four and more, then on the image of the frequency response of LPC spectral maxima can get into different places.

At very large values of the amount of coefficients of LPC, image will contain an excessive amount of details, which may hinder its interpretation and usage.

5) Resolution in Hz – value that determines the accuracy viewing of the resulting spectral image. In contrast to conventional spectrograms this parameter is not defined by length of the window and is selected by an operator from the list: 1,3; 2,6,5,3; 10,7; 21,5; 43,0; 86,1; 172,2; 344,5; 689,0 Hz.

The recommended value of resolution according to frequency is 20-40 Hz, it is roughly 5% of minimal frequency of examined formants. Five percent is a statistical value; it is the difference between the positions of the formants in two different implementations of the same material by one speaker. With decreasing of resolution, rate calculation becomes much slower.

6) It is recommended to have the amount of smoothing filter equal to 0, since in this type of spectral analysis, the procedure of calculating the response of LPC provides good smoothing of the spectrum, so additional usage of smoothing filter is impractical.

7) Data processing area: Selected Area; Visible in Window; Entire Signal.

8) The button allows choosing one of the ready-made profiles:

1. Formants (Fig. 104)

2. Smoothen formants (Fig. 105)

3. Harmonics (Fig. 106)
Other parameters are described in Section 10.1 of this manual.
It's recommended to set the beginning of the upsurge from 1000 Hz, and the rate of it - 10 dB per octave, as the initial values for the selection of the upsurge of the spectrum amplitude.
11.5.3 Calculations’ results

After completion of calculations, the LPC spectrogram will appear in the selected data window (Fig. 107).

The resulting image of the LPC spectrogram (of frequency response) should be compared with the image of the FFT spectrogram to make sure that the available spectral peaks in the image of frequency response of LPC correspond to the position of formants in the FFT spectrogram, i.e., that the choice of calculation parameters was optimal.

The image of the LPC spectrogram in the data window can be optimized by means of visual settings as described in paragraph 10.4.2 of this manual.
11.6 Cepstrum

Generally accepted model of speech production is a model in which the speech signal is regarded as the convolution of two functions, one of which describes the excitation function of the vocal tract, and another – a relatively slow time-varying transfer function of the vocal tract. Cepstrum analysis, realized in the program, makes it possible to separate these two functions and determine the required parameters without their mutual interference.

This type of the analysis provides the ability to detect repeating over time components in the test signal, select the rapidly changing and slowly changing components in a signal and to separate them according to the representation space.

These features in the analysis of speech signals allows using cepstrum, primarily for the separation and subsequent separate treatment of characteristics of rapidly varying periodic vocal excitation of signal and characteristics of slowly varying in time formant filter.

Indeed, on the cepstrum time axis, characteristics of formant filter of a speaker are reflected initially 1.5-3.0 ms, and frequency characteristics of the voice source are displayed in a range of standard lengths of periods of the pitch: 5-12 ms for men and 3-6 ms for women. The periodicity degree of the signal is expressed in the contrast ratio of the selection of the amplitude maximum of the cepstrum in the surrounding background.

Thus, just as the spectrogram makes it possible to obtain the easy "readable" resonance peaks of the spectrum - formants of the vocal tract, cepstrum allows representing in a clear and "transparent" manner the characteristics of frequency of voices: its main and additional periods, the periodicity degree, boundaries of tonal and noise sounds, the dynamics of all these characteristics.

In contrast to the autocorrelation function of the signal, obtained images have much less "extra" peaks. Compared with narrowband spectrograms, cepstrum description makes it possible to determine the periodicity degree of the signal independently of signal quality and, in particular, of the first harmonic of the pitch.

Using cepstrum, the analysis of the speech signal can be carried out in the following areas:

1. Calculation of the impulse response of the transfer function of the vocal tract or calculation of the smoothed spectrum of examined segment of the speech signal. Construction of a dynamic cepstrum, allowing to estimate articulatory features of pronunciation and to obtain statistical information.

2. Verifying the accuracy of curve extraction of the pitch and setting the boundaries: tone, noise, and pause for a variety of procedures of the pitch selection.

3. Detection and characterization of stationary noise characteristics, such as reverb, echo of communication channels, stationary and slowly varying according to the signal noise.

4. Detecting the presence and fixation of location of speech segments in noisy areas of the signal.
11.6.1 Material preparation

To calculate successfully the cepstrum it’s necessary to perform the following preparatory steps with the initial material.

Normalize the entire speech material in amplitude at 32000-32767 with 16-bit ADC / DAC.

Listen to all the material and analyse its oscillogram. Remove segments of the signal which are of no interest for analysis.

Repeat the normalization of the remaining signal if the remote segments of signal were much higher in amplitude than the useful signal.

Cepstrum analysis of speech periodicity is not very sensitive to the amplitude of the input signal, however, it’s important to trace the amplitude of the quietest parts of the test speech signal; it should be at least 50 quanta ADC. Such segments of speech signal should be re-entered, gaining input signal before entering ADC. Sometimes, for signals with a large differential of loudness between individual segments of useful signal it’s recommended to input the signal twice, changing gain every time. In this case examination of the quietest and loudest segments of the signal is carried out using different files containing the input signal.

Further it’s important to make the trial calculation of cepstrum for a relatively short signal segment (3-10 sec). As a test, select a loud signal segment with sounding speech.

You must perform the following steps:

– place an oscillogram of the processing signal segment in the first window;
– perform a calculation of a trial cepstrum;
– optimize graphic image (size, scale);
– link oscillogram and cepstrum windows;
– listen to the examined fragment of the signal;
– make sure that the function of the signal frequency is visually highlighted and its presence sufficiently corresponds to the location of tonal speech segments of oscillogram;
– otherwise optimize the calculation parameters of cepstrum and/or conduct a preliminary signal processing (filtering, Noise reduction, input with more or less gain).

The ultimate goal of cepstrum analysis (in the study of the problem of melodic speech processing) is to obtain a clear image of function of periodicity signal degree in the form of visually readily determinate narrowband (1-3 ratio) of values that is much higher than the background values on the amplitude (in several times), smoothly varying in accordance with the pitch of voice (usually in the range of 80-400 Hz for frequency scale) and vanishing (compared with the background) for non-periodic (not tonal) signal segments.
11.6.2 Choice of calculation settings

To open the dialog box of the cepstrum construction, on the Analysis menu, click Cepstrum... (Analysis → Cepstrum...) or click the Cepstrum button on the vertical toolbar.

In the Cepstrum field (Fig. 108), specify:

1) Frame size in points or ms.

In calculating the cepstrum, the length of the analyzed window must exceed the duration of at least two long for the signal periods of the pitch and should be a multiple of a power of two, this is usually 512 counts for low male voices, and 256 for female and high male voices at a sampling rate 10,000 Hz.

Cepstrum and the periodicity function of the signal reflect the specific structure of the signal more accurately while increasing the analysis window. However, if the signal during an interval of the analysis was changed substantially, the measured characteristics would be averaged, “fuzzy”. For this reason, while performing the periodicity analysis, it’s important to choose the shortest window, and the frequency of the signal should be viewed in details in this window, but from another point of view, the longest window in which the melodic structure of the signal is not too smoothed.

2) Step size in points or ms.

The shift step should be usually 1/4 or 1/8 window length. With decreasing the shift window, the image becomes more detailed and smooth, but the calculation time also increases. In a detailed analysis of the frequency on small segments of the signal, it’s possible to select a shift step between frames that is equal to half of the shortest period of the pitch. If so, the frequency function will be maximally detailed. When selecting from the dropdown list the window size, the step is set automatically in the program; it’s equal to one quarter of its size.

3) The type of the weighting window: Hamming, Hann, Nuttall, Rect, EquPeriod, Gauss.

To obtain more graphic and detailed image of periodicity function it’s recommended to use Hamming’s window. In the analysis of the frequency, the weighting window type does not play a role in terms of accuracy of the analysis, but window type can be used effectively by setting a choice of window different effective duration of the
analysis window. Selecting different windows allows you to vary the effective width of the window, reducing it from a rectangular to 1.36, 1.5, 1.8 times (for Hamming, Hann and Nuttal windows).

When analyzing male and female voices, the analysis frame length 51.2 ms with Hann’s window should be used.

In the analysis of signals with rapidly changing tone, it’s necessary to go to the Nuttal’s window or reduce the frame length to 25.6 ms, without using a window or using a Hamming’s window.

When analyzing high and children’s voices (for example, with a tone in the range of 250-400 Hz) it is advisable to use Hann’s, Nutall’s window of 6.25 ms.

When performing the formant structure analysis using cepstrum, the choice of the analysis window characteristics should be carried out as in the usual spectral analysis (typically Hamming’s window is 25.6 ms).

4) The amount of points of the smoothing filter.

Using the filter enables to perform geometric average of individual cepstrum samples in obtaining image, as a result image is clearer in the background noise, but it loses accuracy.

Usually, when calculating cepstrum, averaging is not used, i.e. filter value is 0. It is sometimes useful to set this option, equal to 3-5 for too fuzzy and jagged cepstrum, especially with low-key tone.

In view of the sign variation of cepstrum, usage of the filter in some cases can lead to the disappearance of narrow cepstrum peaks on cepstrum.

5) Data processing area: Selected Area; Visible in Window; Entire Signal.

6) The button allows choosing one of the ready-made profiles: (Fig. 109):

Other parameters are described in Section 10.1 of this manual. Additionally, it’s essential to take into consideration the following information.
The first two parameters of the **Normalization** field refer to the possibility of increasing in the image of cepstrum frames of amplitude of coefficients with high numbers in relation to the coefficients with low numbers. The direction of the axis of numbers of cepstrum coefficients corresponds to the time axis. Every cepstrum coefficient describes the degree of signal frequency with the period of time, to which this coefficient corresponds.

The upsurge of the amplitudes of coefficients will start from the coefficient, which number is entered in the field **Ascending from ... points**. Recommended values are the upsurge from 1 point of 3 dB/oct.

For low-quality sound records to ensure a more stable extraction of the pitch, you should select coefficients manually according to the images of the dynamic cepstrum so that the peak of the pitch stood out from the background most clearly.

The **Normalize to slice maximum** parameter allows you to set the normalization of the image of each frame (window) of analysis on the maximum amplitude of the frame. The cut, in accordance with the established terminology in digital signal processing, is the calculation result of characteristics of the signal for the frame.

In case of **Entire Signal** before displaying on the screen of the data analysis of each frame, its amplitude is divided by amplitude maximum for all cepstrum components of the frame. Thus, the images of all cepstrum frames are aligned according to the maximum amplitude and the weak (according to the energy) components become visible on the same scale as the strong components.

If you select **None** this normalization is carried out only for the frames of the analyzed signal; the average amplitude of oscillogram in the frame of analysis exceeds the threshold, specified in **Normalize signal, which is higher than the level: ...% of maximum**. In this case, all examined features of the behavior of signal characteristics without excessive and random parts for too weak signals can be observed in the image.

The **Null frequency consideration** parameter, if selected, allows you to take into account null coefficient of calculated signal characteristics while averaging in the **Smoothing Filter** parameter. Null cepstrum coefficient is often much larger in amplitude than the other coefficients, so its exclusion in the construction of images can provide a smaller dynamic range of the data set and, thus, the greater visibility of the images.
11.6.3 Calculation’s results

After completion of calculations, the image of cepstrum will appear in the selected data window (Fig. 110).

![Figure 110 – Data window with the “Cepstrum” signal and visual settings](image)

To research the cepstrum, all means of the data window are available; please refer to Section 7.3 of this manual.

The image of cepstrum in the data window can be optimized by means of visual customization. To do this, use one of the following methods:

1) In the context menu of the main window, click **Visualization Settings**.
2) On the **Service** menu, click **Visualization Settings** (Service → Visualization Settings).  
3) Click **Visualization Settings** on the vertical toolbar.

In data window (Fig. 110), two sliders below the horizontal scale will appear.

The left slider changes the brightness value, specified in the **Visualization Settings** field, and the right slider- the contrast. Operative selection of these values also allows achieving optimal data representation of cepstrum.

To remove the elements of visual customization, re-click **Visualization Settings** on the vertical toolbar.

If select the **Auto apply settings** check box in the dialog box of cepstrum construction, then to optimize the image it'll be possible to use changes of any parameters of the window.

The image, built before, will be redrawn immediately when choosing a new value from the drop-down list or when presetting a new number and clicking **Enter** on your keyboard.
11.7 Autocorrelation

The autocorrelation function is calculated using the inverse Fourier transformation of the power spectrum of the speech signal. Based on the values of the autocorrelation function, calculation of characteristics of the model of a linear prediction of speech, on the basis of which it is possible, in particular, to construct the envelope of the spectrum, which corresponds to the selected model predictions.

Autocorrelation analysis is mainly carried out to detect periodic over time components in the signal - most often to highlight the pitch of speech segments. The degree of periodicity of the signal is expressed in the proximity of the image intensity of amplitude maximum of autocorrelation to the image intensity of its null coefficient.

Dynamic autocorrelation allows to represent in graphic form characteristics of the periodicity of voice: its basic tone, the degree of periodicity, the boundaries of tonal and noise sounds, dynamics of all these characteristics. Autocorrelation gives more "extra" peaks than cepstrum, since while being calculated there is no separation of characteristics of the vocal tract and excitation of the vocal folds. Autocorrelation analysis is commonly used for:

– Analysis of characteristics of the voice periodicity for the selected speech signal and determination of the average value of the pitch of the speaker.

– Control of correctness of curve allocation of the pitch and setting of boundaries; tone, noise, pause for a variety of procedures of pitch selection.

– Analysis of the presence of periodic and reverberation noise in the signal.

11.7.1 Choice of calculation parameters

To open the dialog box of the autocorrelation construction, on the Analysis menu, click Autocorrelation… (Analysis → Autocorrelation…) or click the Autocorr. button on the vertical toolbar.

In the Autocorrelation field (Fig. 111) specify:

1) Frame size in points or ms.

Fixed size of window (frame) of analysis must be at least twice more than the possible maximum value of required periodic component. When choosing a frame size it's necessary to take account of that if the characteristics of the
speech signal are changing rapidly, it is inexpedient to choose too large frame size. For example, in case of rapid change of tone value, large frame won’t give the possibility to trace the dynamics of curve motion of the pitch. And in case of a small length of tonal areas, the size of areas, on which the autocorrelation has a pronounced peak, which characterizes the presence of periodicity, will be reduced then.

2) Step size in points or ms. It determines the shift along the time axis in the direction of its increase for each subsequent frame of analysis in relation to the previous one. Step determines the distance (over time) between sequential autocorrelation frames. By default, it is set automatically by the program, equal to one quarter of the selected window size.

3) The type of the weighting window: Hamming, Hann, Nuttall, Rect, EquPeriod, Gauss.

Usually, when calculating the autocorrelation Hamming’s window is used.

4) The amount of points of the smoothing filter.

Calculation’s results in each frame are smoothed by moving average filter, that is symmetrical with respect to point for which smoothing is performed. Number of average points corresponds to a given number in this parameter.

5) Data processing area: Selected Area; Visible in Window; Entire Signal.

6) The button allows choosing one of the ready-made profiles: (Fig. 112):

Other parameters are described in Section 10.1 of this manual.

When selecting, editing and pre-processing speech material for the calculation of autocorrelation function you should follow the recommendations, depicted in paragraph 10.6.1.
11.7.2 Calculation’s results

After completion of calculations, the image of autocorrelation will appear in the selected data window (Fig. 113).

![Figure 113 – Example of data window with autocorrelation image](image)

Image of autocorrelation in the data window can be optimized by means of visual settings as described in paragraph 10.6.3 of this manual.

Autocorrelation gives more often fails than cepstrum in determining the value of the pitch (i.e., in the area of possible value of tone, autocorrelation maximum is not at the point corresponding to the pitch, but, for example, at any its harmonics). So to make the correct conclusion about the value of the pitch period you should take into account the autocorrelation functions, calculated at adjacent intervals of speech.
11.8 Energy

Energy curve is typically used to segment the speech stream and to determine the threshold energy of the signal, which is used to cut off pauses in the signal in the calculation of the pitch.

Energy calculation is the calculation of the square root of the moving average of the squared signal in the program. The operator sets the frame length over which averaging is occurred.

When calculating the energy value in any point, the program takes N/2 values of the signal to the right of this point, and N/2 values of the signal to the left of this point (N - defined by the operator frame length in counts). At even N frame length is increased by one count.

For example, if an operator, at a sampling rate of the active signal of 10 kHz, set the frame length of 1 ms, this corresponds to 100 counts. Then, to get the amount of energy at any point of the signal, the system takes the 50 values of the signal on the left of the point, 50 - on the right; every value is squared, the results are summarized, the sum is divided by 101 and from the resulting number the square root is extracted.

In all cases the frame, according to which the averaging occurs, is shifted according to the signal of 1 count.

To open the “Energy” dialog box, on the Analysis menu, click Energy... (Analysis → Energy...) or click the Energy button on the horizontal toolbar.

In the dialog box (Fig. 114) specify:

1) The data processing area: Selected Area; Visible in Window; Entire Signal.

2) Frame size in ms.

The length of the frame to calculate the energy of speech signals should be 10 - 30 ms.

The length of the frame should not be less than two periods of the pitch.

For signals with different sampling rates, the same frame length of analysis corresponds to different numbers of samples. For example, 20 ms corresponds to 200 counts at a sampling rate 10000 Hz and 400 counts at the sampling frequency 20000 Hz.

The larger the length of the analysis window is used while calculating the energy, the more smoothed energy curve is received as the result of energy calculations.
3) Window to hold the result.
To determine the threshold of pauses it’s necessary to extract tone areas in the signal and define minimum energy value in them.
This can be done easily in the presence of a visible connection between the signal waveform and the energy curve.
The most convenient way is to combine images of oscillogram and energy curve in one box. For this purpose, when calculating the energy, the waveform window is selected as a window to hold the result.
In this case, the curve of energy will be drawn over oscillogram with other color (Fig. 115).

![Figure 115 – Combination of energy curve with oscillogram](image)

Click the **Apply** button to launch the process of energy calculation or the **Close** button in the upper right corner of the dialog box to cancel.
11.9 Zero Cross Frequency

In terms of perception, the frequency zero crossing value corresponds to the overall evaluation of timbre on the scale of high frequency/low frequency, deaf/ringing, hissing/whistling.

The curve of zero-crossing frequency is most often used for segmentation of the speech flow, as well as in determining the threshold for cutting off parts of speech with a strong high-frequency noise in the calculation of the pitch.

It’s possible to use the curve of zero crossing to determine the saving of nature of noise in the analysis of sound records with aim to detect traces of arrangement.

To determine the threshold at frequency of zero crossing it is necessary to distinguish in the signal tone and high-noise segments and to determine the maximum value of frequency of zero crossing on tonal segments. This value is used as the threshold for cutting off the noise, i.e. those segments of the signal, on which frequency value of the zero crossing exceeds a predetermined threshold, are considered to be noise.

In calculating the frequency of zero crossing, the average frequency of the change of a signal sign on the frame of analysis is calculated, whose length (in counts) must be specified by operator.

In calculating the frequency of zero-crossing at any point, the program takes N/2 counts on the right of this point, and N/2 counts on the left of this point (N - defined by operator frame length in counts), and it calculates the number of signal sign change in this interval and divides this number by the length of the interval in seconds. For even N frame length is increased by one count.

Interval in calculating process is shifted by one point to calculate the next value. The result is calculated in hertz.

To open the Zero Cross Frequency dialog box, on the Analysis menu, click Zero Cross Frequency... (Analysis → Zero Cross Frequency...)

![Zero Cross Frequency dialog box](image)

In the dialog box (Fig. 116), specify:

1) In the Process field, select the data processing area: Selected Area; Visible in Window; Entire Signal.
2) Frame size in ms.
3) Window to hold the result.

The length of the frame analysis for speech signals is usually set not less than 12 ms.
Thresholding is convenient to carry out, when images of a dynamic spectrogram and curve of zero crossing frequency are combined.

For this purpose, when calculating the frequency of zero crossing, as a window for placement of results, it’s recommended to use a window with a dynamic spectrogram.

Press the **Apply button** to launch the process or the **Close** button in the upper right corner of the dialog box to cancel.

After performing the calculations, the result is displayed in the selected window (Fig. 117).

![Figure 117 – The combination of curve of zero crossing frequency and the spectrogram](image-url)
11.10 Averaging

In the program for any type of visible speech (spectrogram, cepstrum, LPC, autocorrelation, etc.) it is possible to apply the averaging operation.

Visible speech, in fact, is a three-dimensional object, two of the three dimensions of which are time and amplitude of parameter. Averaging operation is performed as follows: the corresponding counts of each time slice are summed without using weights, then each of the resulting sum is divided by the number of time slices. The resulting one-dimensional array is called the averaged response.

In calculating the average characteristics of visible speech it’s possible to calculate, except for the actual average characteristic, the average variance and cross-correlation of three-dimensional data.

The three-dimensional data variance is the following quantity:

$$\sigma_k^2 = \frac{1}{M-1} \sum_{i=1}^{M} (S_{ki} - \bar{S}_k)^2$$

where M - number of time frames of analysis in the area of averaging, k - number of element in the array of calculated variances (defined by length of the frame when calculating the visible speech), Ski - the value of visible speech on the time slice i with the number of the element k, Sk - average value of the item with the number k averaged over all frames.

The square cross-correlation is a one-dimensional array whose elements are calculated in accordance with the formula:

$$A_k^2 = \frac{1}{M-1} \sum_{i=1}^{M} (S_{ki} - \bar{S}_k)(S_{kj} - \bar{S}_k)$$

Symbols correspond to the previous formula.

To open the Average dialog box, on the Analysis menu, click Average... (Analysis → Average...). The operation of averaging is only applicable to visible speech, so the command becomes active when you select windows with visible speech as the source of the analysis.
In the dialog box (Fig. 118), specify:

1) If necessary, select the **Calculate cross-correlation** and **Calculate Variance** check boxes.

2) In the **Process** field, select the data processing area: **Selected Area; Visible in Window; Entire Signal**.

3) Window to hold the result.

Press the **Apply button** to launch the process or the **Close** button in the upper right corner of the dialog box to cancel.

After performing the calculations, the result is displayed in the selected window (Fig. 119).
11.11 Histogram

11.11.1 Histogram's construction

The method of calculating the histogram is as follows:
– entire interval from the lower limit to the upper limit with a given step is divided into subintervals;
– each subinterval corresponds to a histogram value: if the value of analyzed signal falls in a given interval, the value of the histogram in it is increasing by 1.

After analyzing all the values of the initial signal, we obtain a histogram. Furthermore, it is normalized so that the sum of all values of the histogram, multiplied by the length of the interval, would be equal to unity.

Thus, the actual value of the histogram after normalization is equal to the density of probability finding of a given value signal. As a result, if the histogram is smooth, it does not depend on the step. This can be easily verified, for example, calculating the histogram of loud speech waveform in the range from -500 to 500 in increments of 2, 5 or 10 counts.

To construct histogram, on the Analysis menu, click Histogram... (Analysis → Histogram → Build).

In the dialog box (Fig. 120) specify:
1) The minimum and maximum values and a step.
2) In the Process field, select the data processing area: Selected Area; Visible in Window; Entire Signal.
3) Window to hold the result.

Press the Apply button to launch the process of histogram construction or the Close button in the upper right corner of the dialog box to cancel.

After performing the calculations, the result is displayed in the selected window (Fig. 121).
Figure 121 – Window with the histogram construction result
11.11.2 Measurement of the histogram

Measurement of the histograms is used to compare two histograms plotted for different speech signals. To measure (compare) the histograms:

1) Construct two histograms for different speech signals, as indicated in paragraph 11.11.1 of this manual.
2) On the Analysis menu, click Histogram... (Analysis → Histogram → Measure).

The command is available only if the tab of the data window with constructed histogram is active.
3) Get to know the result of comparison in the window “Compare histograms” (Fig. 122).

![Figure 122 – Window with the result of histograms’ comparison](image-url)
While making an identification study of samples of the speech material, a group of statistical characteristics of the melodic curve is the compulsory identification features. These statistical characteristics can be obtained by processing the melodic curve (the curve of pitch). 

Software module, which is part of the specialized Sound editor **SIS II, Pitch Extractor Plugin** (Fig. 123), created as a loadable dynamic link library **PitchExtractorPlugin.dll**, automatically performs the search and selection of values of pitch in the signal.

![Figure 123 – Module options “Pitch extraction”](image)
12.1 Material preparation

In order the statistical characteristics fully reflect the personality of investigated speakers, it is necessary that the understudy speech material had sufficient representation, namely:

– Duration of the test speech signal must be at least 30 seconds of pure sounding speech, of which not less than 20 seconds of the tone;

– Desirable options: the limits of bandwidth of useful speech signal should be of at least 300-1500Hz, band frequency of signal should be no less 600 Hz (for example from 300 to 900 Hz) and the presence of the first harmonic of the pitch;

– There must be different linguistic categories in relatively equal quantity in the speech signal of compared samples. In particular it is important that the compared material would have the same number of interrogative and declarative sentences.

To improve the reliability of the results obtained by comparing the statistical parameters of the melodic curve for different speech signals, it is necessary the understudy speech material met the following requirements:

– comparability on the type of speech (reading, by heart, retelling, reading one's own or another's text, deliberate speech, spontaneous speech, good or bad knowledge of subject being in discussion);

– Comparability according to the type of intonation of phrases of material (question, narrative, motivation)

– Comparability according to the emotional type of phrases (type of emotions: excitement, sadness, normal)

– Comparable according to the used audio channel (channel type: phone, microphone, etc.).

Satisfying the above requirements, speech signals are entered into computer storage and are edited as follows:

– Fragments of signals containing speech and non-speech interference are removed;

– If necessary, Noise reduction is performed;

– Normalization of each replica is performed in order to avoid the use of signals whose amplitude is below the 1000 counts.
12.2 Extraction

To calculate the pitch automatically, on the Modules menu, click **Pitch Extractor Plugin (Modules → Pitch Extractor Plugin)**.

In the **Pitch extraction** dialog box (Fig. 124) specify:

1) Data processing area: **Selected Area; Visible part; Entire Signal**
2) In the **Use Channel** field, select necessary check box (**Left Channel, Right Channel**)
3) Window to hold the result (**Destination window**)
4) File for which the pitch is calculated.

There is a capacity in the program to select several files by selecting check boxes in the dropdown list (Fig. 125) or all files by clicking the **Select all files** button.

To start the process of extraction of pitch, click **Extract**.

To cancel the process of extraction of pitch click **Cancel**.
The process of calculating of the pitch takes time and it is displayed in the Task Viewer window. The process can be interrupted by pressing the button on the right of the display of operation process.

After completing the process of calculating of the pitch, the result will be displayed in the following window (Fig. 126).

To verify the accuracy of calculation of the pitch, specify the window with cepstrum to hold the calculation result of pitch. After calculating, on the cepstrum background the pitch curve will be drawn. The pitch is calculated correctly if in absolute majority of areas the pitch curve coincides with the function of the main signal frequency in cepstrum.
Formant analysis is complementary option to the calculation of formants in obtaining the dynamic spectrograms. Formant analysis allows us to calculate only the formants (without the spectrogram) and to represent the formants of different signals over each other.

Software module, which is part of the specialized Sound editor SIS II, Formants Extractor (Fig. 127), created as a loadable dynamic link library FormantsExtractorPlugin.dll, automatically performs the search and selection of formants in the signal.

![Module options “Formants extraction”](image)
13.1 Choice of extraction parameters

To increase the visibility and effectiveness of formant trajectories construction, on the **Path drawing** tab of the **Options** dialog box (refer to Fig. 21), specify beforehand:

1) Line thickness within the range from 1 to 5.
2) Method of the formant drawing: **Stair-step** or **Linear Approximation**.
3) Frequency search range from 10 to 500 Hz;
4) Number of averaging spectra from 1 to 33;
5) Sound frequency hint line color;
6) Formant path color.

To calculate formants automatically, on the **Modules** menu, click **Formants Extractor (Modules→Formants Extractor)**.

![Formants extraction dialog box](image)

In the **Formants extraction** dialog box (Fig. 128) specify:

1) Data processing area: **Selected Area; Visible part; Entire Signal**.
2) In the **Use Channel** field, select necessary check box (**Left Channel, Right Channel**).
3) Window to hold the result (Destination window)

4) In the Gender field, select necessary check box (Male, Female)

5) In the Source field, select necessary check box (Microphone, Telephone)

5) File for which the pitch is calculated.

There is a capacity in the program to select several files by selecting check boxes in the dropdown list or all files by clicking the Select all files button (Fig. 128).
13.2 Extraction

To start the process of pitch extraction, click **Extract**.

To cancel the process of pitch extraction, click **Cancel**.

The process of pitch extraction takes time and it is displayed in the **Task Viewer** window. The process can be interrupted by pressing the button **X** on the right of the display of operation process.

After completing the process of pitch calculation, the result will be displayed in the following window (Fig. 129).

![Figure 129 – Extraction’s result of formants](image)

Using the icon **B** and the field of data representation transparency degree of the **Windows** tab **Manager Panel** it is possible to make sure whether images of formants from the different signals, superimposed one on another coincide or not.
14.1 Creation of a report

Report is created for the active project, chosen on the Projects tab of control panel.

To create the report, on the File menu, click Project Management, and then Create Report (File ➔ Project Management ➔ Create Report).

If the project isn’t selected, a message stating that there is no active project will appear.

If the project is selected, the window with the predefined report will appear in a text editor (Fig. 130).

Figure 130 – Window of a text editor Microsoft Word with report
There is an opportunity to use your own report form, if you put it with the name `ReportsWorkblank` in catalog `C:\Program Files (x86)\Speech Technology Center\SIS II` (Fig. 131).

Figure 131 – Report form in the catalog of "SIS II"
14.2 Operation with report’s text

To operate with report's text, all capacities of the text editor Microsoft Word are fully accessible. You can insert text and graphics data of this sound editor into the report’s text, obtained by clicking the **Copy** button or from the context menu.

On the **File** menu, click **Signal Properties** or in the context menu of data window by right clicking the mouse, to obtain data of the active tab of the data window.

Information will be depicted in the **Signal Properties** window (Fig. 132).

![Signal Properties window](image)

To copy information from the **Signal Properties** window to the system clipboard, click **Copy**. If then in the text editor click **Paste**, information about the properties of signal and waveform will be inserted at specified text’s place.
14.3 Report’s saving

To save a report with a new name (Fig. 133) use the text editor Microsoft Word. By default, the generated report is stored in the directory:

C:\Users\<user_name>\Documents

![Figure 133 – Saving file report from the text editor Microsoft Word](image)
14.4 Report’s removing

To delete the reference to report’s file from the **Projects** tab, choose file’s name and in the context menu click **Remove** (Fig. 134).

![Figure 134 – “Projects” window with selected report to remove](image)

After clicking **Remove** a warning will appear (Fig. 135).

![Figure 135 – Removing operation window](image)

To remove completely or copy the report from the directory `C:\Users\<user_name>\Documents`, which is situated in the format file Microsoft Word, use the standard tools of the operating system Microsoft Windows.
15 OPERATION WITH THE SIGNAL GENERATOR

To create various test signals, the program has the ability to form different types of pulsing, harmonic and noise signals with the specified parameters.

15.1 General settings of the generator

To create a trial signal, on the **Service** menu, click **Signal Generator...** (Service → Signal Generator). The “Signal generator” dialog box will appear, as in Figure 136.

![Figure 136 – “Signal generator” dialog box, the “Pulsing” tab](image)

This window has three tabs, on which you can specify the parameters of various pulsing, harmonic and noise signals, as well as of the general field:
OPERATION WITH THE SIGNAL GENERATOR

- in the **Signal length** field, specify the duration of the generated signal in seconds;
- in the **Sampling rate** drop-down box, specify the sampling rate of the generated signal;
- generate a stereo signal, select the **Stereo** check box;
- generate a 24-bit signal instead of 16-bit, select the **24-bit signal** check box;
- save the defined settings (parameters) of the generated signal in the list of presets;
- previously saved settings from the list of presets.

To save new settings (profiles) of the generated signal in the list of presets, click **Save...**; in the dialog box (Fig. 137) specify preset name and click **OK**.

![Figure 137 – Preset name](image)

To apply the saved variant of preset settings, double click the left mouse button in the list of settings (Fig. 138).

![Figure 138–Changing of preset settings of the generated signal](image)

To delete the previously saved variant of preset settings from the list, select it in the list of settings and click **Remove** (Fig. 139).

![Figure 139– Removal of preset settings from the list](image)

After selecting signal type and setting the appropriate parameters, click **OK** in the **Signal generator** dialog box. Generated test signal with the given parameters will be created by the program in a new data window.

To cancel signal generation, click **Cancel**.
15.2 Generation of pulsing signals

On the **Pulsing** tab there a capacity to choose the following types of signals:

- Trapeziform pulse;
- Rectangular pulse;
- Saw pulse;
- Delta pulse.

When choosing a trapeziform pulse signal (Fig. 140) there is a capacity to specify:

1. **Rise**...sec – duration of the upsurge of pulse amplitude to a maximum value
2. **Duration**...sec – duration of keeping of amplitude maximum value
3. **Decay**...sec – duration of slope of pulse amplitude to zero
4. Amplitude magnitude for the first **A... counts** and for the second **B... counts** pulses
5. Frequency of pulse movement.
When choosing a rectangular pulse signal (Fig. 141) there is a capacity to specify:

1. **Duration**...sec – duration of rectangular pulse
2. Amplitude magnitude for the first **A... counts** and for the second **B... counts** pulses
3. Frequency of pulse movement.

When choosing a triangular pulse signal (Fig. 142) there is a capacity to specify:
1. **Rise**...sec – duration of the upsurge of pulse amplitude to a maximum value
2. **Decay**...sec – duration of slope of pulse amplitude to zero
3. Amplitude magnitude for the first A... counts and for the second B ... counts pulses
4. Frequency of pulse movement.

If the value of a decay or rise will be zero, it will be saw pulse signal as a result.

![Parameters of delta pulse](image)

For a delta pulse signal (Fig. 143) you should only specify the amplitude magnitude for the first A... counts and for the second B ... counts pulses, and frequency of pulse movement.
15.3 Generation of harmonic signals

On the **Harmonic** tab there a capacity to choose the following types of signals:

- Sine signal.
- Sweep signal.

![Figure 144 – Parameters of sine signal](image)

For sine signals (Fig. 144) specify the following parameters: **Frequency, Hz** or **Period, sec**; **Magnitude, counts** or **Phase, degree**.
For sweep signals (Fig. 145) specify the following parameters:

1. The boundaries of sweep frequency **From...Hz** or **To...Hz**

2. **Speed...Hz/sec** – speed of reconstruction of frequency within the specified boundaries of the swing

3. **Magnitude...counts** – amplitude of signal

4. The direction of reconstruction (swing) of frequency: **From..To..From** or **From..To..From..To**
15.4 Generation of noise signals

For noise signals (Fig. 146) specify the following parameters:

1. Necessity to initialize the random number generator with specified number. For this purpose select the **Init random generator as** check box.
2. Maximum magnitude of noise in counts.

![Figure 146 – Parameters of noise](image-url)
To shut down the program, on the **File** menu, click **Exit** (File→Exit) or click the **Close** button in the right corner of the program.

If any data obtained in processing hasn’t been previously saved, a warning will appear (Fig. 147).

This window will appear also when trying to close any data window with unsaved changes.

To save the current file, click the **Save** button. If there are unsaved files in the program, a warning will appear again.

The process of data storing may take some time; it appears with the following message (Fig. 148).

To save changes in all files, click **Yes to All**.

To exit without saving the current file, click **No**.

If there are unsaved files in the program, a warning will appear again.

To exit without saving any changes, click **No to All**.

To continue working with program, click **Cancel**.
17 TROUBLE SHOOTING

17.1 Warnings and Errors

Table 1 – Warnings and errors that may appear while operating with the program

<table>
<thead>
<tr>
<th>Error/Warning</th>
<th>Problem solving</th>
</tr>
</thead>
<tbody>
<tr>
<td>If there is no <strong>HASP</strong> protection key, an error message will be displayed.</td>
<td>Click <strong>OK</strong>, plug the key in the USB-port and repeat the procedure of starting the program.</td>
</tr>
<tr>
<td>If the project name field is blank or it contains spaces or other invalid</td>
<td>Click <strong>OK</strong> and enter the correct name of the project.</td>
</tr>
<tr>
<td>characters, an error message will appear.</td>
<td></td>
</tr>
<tr>
<td>If while selecting the processing or analysis operations, the window, which</td>
<td>Click <strong>OK</strong>, and make available the window with the appropriate type of signal.</td>
</tr>
<tr>
<td>doesn’t contain the desired data, is available, a warning message will appear.</td>
<td></td>
</tr>
<tr>
<td>If the project is not selected, then when trying to create a report, a</td>
<td>Click <strong>OK</strong> and then select the project in the <strong>Projects</strong> tab of the Manager Panel.</td>
</tr>
<tr>
<td>message will appear stating that there is no active project.</td>
<td></td>
</tr>
<tr>
<td>When trying to hide data of a single tab, there will be a warning in the</td>
<td>Click <strong>OK</strong>.</td>
</tr>
<tr>
<td>data window.</td>
<td></td>
</tr>
</tbody>
</table>
17.2 Technical support

Speech Technology Center carries out service and technical support for its products.

We welcome your feedback, questions, requests and suggestions regarding the software SIS II. Please contact the Speech Technology Center Technical Support:

E-mail support@speechpro.com

Website http://speechpro.com/support_form

When you contact Technical Support, please have the following information available:

– Product release level
– Hardware information
– Available memory and disk space
– Operating system
– Problem description

Interactions with the service desk can be simplified by the built-in program mechanism, aimed to automate registration process, problem solving, submitting of requests and error messages.

In case of errors and failures in the program, operator has an opportunity to contact immediately the producer of the program and report an error.

For this purpose, on the Help menu, click Contact Us and then click New error… (Figure 149).

![Figure 149 – “Help” menu commands]
The **Bug report–New error** dialog box should appear (Figure 150); there is an opportunity to describe an error.

The window appears automatically if there is a failure in the program:

1) Click the **Send** button to send a bug report to the producer (if Internet connection is available).

2) Click the **Prepare** button to prepare a bug report for sending.

3) Click the **Save** button to save a bug report to send it later.

4) Click the **Close** button to close the dialog box without a bug report.

![Figure 150 – “Bug report–New error” dialog box](image)
The **Contact us ▶ New issue...** menu item opens the **Bug report – New issue** dialog box (Figure 151); there is an opportunity to point program operation issues.

![Figure 151 – “Bug report – New issue” dialog box](image)

The **Contact us ▶ Options...** menu item opens the **Options** dialog box (Figure 152); there is an opportunity to customize common settings concerning bug report sending.

![Figure 152 – Common bug report settings](image)
Appendix A: Glossary

A

**Acoustics**

(gr. *akustikos* – of or for hearing, ready to hear)

1. The science of the sound, studying its elastic vibrations and waves.
2. The sound characteristics of an enclosed space or an object (audio device).
3. *Acoustic level of (speech) signal* – a description of concerned signal (especially, speech signal) characteristics as a whole and its elements’ characteristics as a sound physical process without taking into consideration the information transferred by the signal. Usually, the *spectral description* of a signal is used at acoustic level.
4. *Speech acoustics* – a part of general acoustics, studying speech signal structure, processes of speech production and speech perception. It is concerned with developing methods and means of analysis, as well as with speech modeling, identification, synthesis and compression.

**Acoustic and phonetic attributes of oral speech**

The attributes reflecting acoustic qualities of the vocal tract and articulation skills of the person. These attributes are perceived and revealed with the help of technical means and form the basis of instrumental analysis of speech signals; the attributes can be evaluated quantitatively.

**Acoustic depth of sound record**

The distance between microphone and sound source estimated by sounding. Such estimation is possible basically due to gradually changing of sound timbre along with distance to source of loudness and ratio between sound level of given source and surrounding acoustic noise as well.

**Acoustic event**

A single, relatively independent, short- or long-term event being heard in real time or on record. The term is commonly used to indicate sound aspect of events happening simultaneously with main speech signal sounding (e.g. knock, music, sound of passing car or TV set, etc.).

**Active tab**

Tab of active data window, used as a data source. The tab is usually displayed over other tabs.

**Amplitude (magnitude)**

(lat. *amplitudo* – size)

The maximum deviation value (from the equilibrium position) of an oscillating quantity, for example, the deviation from zero of an in-circuit electric current voltage, sound pressure intensity, etc. It represents the size of vibration (deviation value). In strictly periodic vibrations, the amplitude is a constant.

In the research of harmonic sound vibrations, the amplitude means sound pressure in a signal expressed by the amplitude of a current, voltage or other electrical quantity on the output of sound converting equipment.
(microphone). In the signal waveform figure, the amplitude represents the deviation size of an image up or down from zero position.

**Audio codec**

The digital encoding used to represent audio data.

**Audio/sound record**

Speech signal, pre-recorded in the file.

**Cepstrum**

A representation of the speech signal in the form of a set of coefficients, obtained as the result of taking the Fourier transform of the decibel spectrum of the given signal. Such primary representation of speech signal is applied in the automatic speech and speaker recognition systems. Cepstrum is typically used for the MFCC (Mel Frequency Cepstral Coefficients), calculating cepstral coefficients with help of a nonlinear mel scale of frequency. Mel scale is considered to approximate the human auditory system’s response more closely.

**Current (active) window**

A graphic window which serves as a source of data at the current moment. It is always located above all the rest windows. A short name of a current window is outlined in the left top corner of a window.

**Data**

A graphical image in the info data window, gathered while recording audio, reading files, operating with program. A representation of oscillograms (waveforms), spectrograms, histograms and other graphical images.

**(Data) box**

In SIS II, a black rectangular in the graphic window with numbered axes of coordinates. If data is loaded in the window, it will be represented in the data box.

**Data tab**

Independent data that together with other data is stored in one data window while operating with program

**Diagnostic attributes of oral speech**

The attributes which allows one to determine accent/dialect, social, psychological, physiological and other characteristics of the speaker.

**Filter**

An electronic device or program-mathematical algorithm used to remove vibrations of certain frequencies from a composite signal with wideband spectrum while allowing the more narrowband vibrations to pass. A high-pass filter attenuates low frequencies and lets the high ones pass through. A low-pass filter does the opposite. In a more comprehensive sense, filter is any mean of linear modification of input signal spectrum.
Formant
The amplitude maximum, area of energy concentration in the speech sound spectrum, determined by the resonant properties of the vocal tract. In the speech sound 3-6 formants are commonly distinguished within the frequency range from 250 to 5000 Hz. Formant is a phonetic characteristic of sound; it contains information about the speaker’s individual speech features. Formant with the lowest frequency is denoted $F_1$, the second $F_2$, and so on to the highest frequencies.

Fragment
In SIS, the part of data which is singled out in some way from the segment, but has not lost its connection with the remaining data. It can be, for example, part of a segment limited by temporary marks or part of a segment included in the highlighted interval between permanent marks or part of a segment visible in the box.

General software
Set of general-purpose software intended to organize computing process and resolve current problems of information processing.

Hardware Against Software Piracy
Hardware and software protection system of programs and data from illegal usage and unauthorized distribution.

Histogram (bar diagram)
One of the most common ways of graphic data representation. The histogram reflects statistical distributions of numerical value. Histogram is shown as a row of vertical adjacent rectangles (bars), drawn along a straight line. Each bar width represents interval where it is drawn and its area is proportional to the frequency of the corresponding value appearance within this interval.

Mark
A tool to highlight specific data areas in the data window.

Noise
1. Disorderly oscillations of a different physical nature, having continuous spectrum in a sound frequency range.

2. Unwanted sound that complicates the useful signal determination and use. Any oscillation in solids, liquids and gases can be the source of an audible and inaudible noise. Radio-electronic (electromagnetic) noise is a random variation of current or voltage in radio-electronic devices (for example, audio recording and reproducing equipment).

Noise reduction (noise cancellation)
The process of removing unwanted noise (background noise) from a signal.
Normal distribution mixture
A general linear combination of Gaussian functions, used for approximation of various experimental distributions of the acoustic space components.

Operator
A person who uses the program as intended.

Pause
(lat. pausa, gr. pausis – stop, termination)
A break in speech, which acoustically corresponds to the absence of sound, and physiologically – to the stop in the activity of speech organs.

Pitch (fundamental frequency, pitch of sound/voice)
A perceived quality of sound that is most closely related to the frequency of the first harmonic (fundamental frequency) in a discrete spectrum and depends on the size and speed of vocal cords vibrations. In oral speech, this feature determines voice type (bass, tenor, descant, etc.).

Pitch of voice (sound)
A property of voice measured by the vocal folds oscillation frequency in a unit of time: the more oscillations account for a unit of time, the higher is the pitch.

Range
A quantity setting the utmost limits of attribute change (e.g., sounding speech attributes); difference between minimum and maximum values of the attribute.

Signal energy
A root-mean-square signal value in a frame of a set width (in milliseconds), located symmetrically relative to the current point in the signal.

Sound
A mechanical oscillation travelling through elastic mediums or bodies (solids, liquids and gases), composed of frequencies within the limits of human hearing (between about 17-20 Hz and 20 000 Hz). The heightened sensibility of human ear is detected in the frequency range from 1 kHz to 5 kHz. Mechanical oscillation which is lower in frequency than 17 Hz is called infrasound, while ultrasound is an oscillation with a frequency greater than the upper limit of human hearing (20 000 Hz).

Sound spectrum
An acoustic representation of complex sound providing information about the frequency of sound source, pitch harmonics and relative intensity of all its frequency components.

Speaker – a person whose speech in an audio/sound record.
**Speaker identification**
The process of comparing the speech of an unknown speaker against a database of the speech samples of known speakers to determine whether it matches any of the templates or not, i.e. to identify the submitted unknown speaker with any of known speakers.

**Speaker identification characteristics**
The stable individual characteristics of a speaker that are obtained from his speech: appearance and speech characteristics, as well as subjective auditory estimation of a speaker.

**Speaker recognition**
A generalized term including identification, verification and speaker separation.

**Speaker verification**
A procedure of checking whether the speaker, whose speech is analyzed, is the person he pretends to be (e.g. by entering a specific PIN code). Verification itself is one of the pattern recognition problems, when it is necessary to accept or reject a hypothesis of identity of the two given classes (patterns).

**Special software**
Part of the software that is designed during SIS II program generation.

**Spectrogram**
A graphic representation for the results of sound vibrations spectral analysis.

**Spectro-temporal analysis of speech recording**
The instrumental method of speech signal analysis used to establish dependences between the frequency and peak characteristics of speech spectrum and the duration of the speech process. Spectro-temporal analysis provides the most complete representation of speech in the form of a continuously changing spectrum of sound vibrations produced by the resonator parameters of the vocal tract constantly varying in the time domain.

**Speech sound**
A minimum unit of speech flow resulting from human articulation activity. Speech sound is characterized by specific acoustic and perceptive properties.

**Temporary mark**
A yellow vertical dashed line in the data box used for temporary marking fragments of data. There can be from 0 to 2 temporary marks in the box. If you try to set the third mark, the first of the two already set marks will disappear.

**Toolbar**
A row, column, or block of buttons or icons, usually displayed across the top of the screen, that represent tasks or commands within the program. The toolbar buttons provide shortcuts to common tasks frequently accessed from the menus.

**Voice Activity Detection (VAD)**
Software tool to separate active speech from background noise or silence.
Waveform

Waveform of the speech signal is a graphic representation of the signal vibration amplitude as a function of time. Waveforms can be obtained using signal processing equipment: loop waveform viewers, signal level recorders and electronic waveform viewers. Waveforms can be used to extract fragments of data for further research.
### Appendix B: The list of the horizontal toolbar and of the menu bar icons

The horizontal toolbar is a set of buttons to complement or duplicate the individual items of the main menu.

Table B.1 shows the assignment of all the horizontal toolbar buttons and their corresponding keyboard shortcuts.

<table>
<thead>
<tr>
<th>Toolbar button</th>
<th>Action</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td>Opens a dialog box of the operating system “Open...“to select the file. An open file is displayed in a data window on the workspace area.</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save</td>
<td>Saves changes made in a current file</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Recording</td>
<td>Starts recording to hard disk</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Signal Properties</td>
<td>Opens an information window “Signal Properties”</td>
<td>–</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>Undoes the last action</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Redoes an action that was undone</td>
<td>Ctrl+Y.</td>
</tr>
<tr>
<td>Copy…</td>
<td>Copies the selected data fragment</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Copy to New Window…</td>
<td>Copies the selected data fragment to a new data window</td>
<td>Ctrl+Shift+C</td>
</tr>
<tr>
<td>Cut…</td>
<td>Cuts the selected data fragment</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes copied or cut data fragment (by using the Copy or Cut command) into the indicated point of an active or another signal</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Delete…</td>
<td>Removes the selected data fragment</td>
<td>Delete</td>
</tr>
<tr>
<td>Divide stereo to two mono</td>
<td>Separates stereo signal into two mono signals</td>
<td>Ctrl+2</td>
</tr>
<tr>
<td>Merge two mono to stereo</td>
<td>Combines two mono signals into one stereo signal</td>
<td>Ctrl+1</td>
</tr>
<tr>
<td>Draw</td>
<td>Possibility to choose drawing as the editing mode</td>
<td>–</td>
</tr>
<tr>
<td>Erase</td>
<td>Possibility to choose erasing as the edit mode</td>
<td>–</td>
</tr>
</tbody>
</table>

| **View**       |                                                                        |                   |
# APPENDIX

<table>
<thead>
<tr>
<th>Toolbar button</th>
<th>Action</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Entire Signal]</td>
<td>Displays the entire signal in a current data window</td>
<td>F8</td>
</tr>
<tr>
<td>![Selected]</td>
<td>Zooms-in the data fragment located between two temporary marks</td>
<td>Shift+F8</td>
</tr>
<tr>
<td>![Vertical Auto-zoom]</td>
<td>Vertical self-scaling</td>
<td>F7</td>
</tr>
<tr>
<td>![dB]</td>
<td>Changes logarithmic scale to linear and vice versa</td>
<td>–</td>
</tr>
<tr>
<td>![Manager Panel]</td>
<td>Adds or removes the control panel on the right side of the main window</td>
<td>F10</td>
</tr>
</tbody>
</table>

## Playback

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Playback]</td>
<td>Plays the entire signal opened in a current data window</td>
<td>F6</td>
</tr>
<tr>
<td>![Selected Area]</td>
<td>Plays a signal fragment located between the two temporary marks</td>
<td>Shift+F6</td>
</tr>
<tr>
<td>![Intervals]</td>
<td>Plays signal intervals highlighted between constant marks</td>
<td>Alt+F6</td>
</tr>
<tr>
<td>![Visible in Window]</td>
<td>Plays a signal fragment which is currently visible in a data window</td>
<td>Ctrl+F6</td>
</tr>
<tr>
<td>![Pause]</td>
<td>Temporarily stops playback or recording</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>![Stop]</td>
<td>Stops the current playback or recording</td>
<td>Esc</td>
</tr>
<tr>
<td>![Go to Start]</td>
<td>Restarts playing a signal from the start position depending on a playback mode selected originally (From Cursor, Selected area, Intervals, Window area)</td>
<td>–</td>
</tr>
<tr>
<td>![Loop]</td>
<td>Loops playback mode</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>![Pseudo Stereo mode]</td>
<td>Possibility to use pseudo stereo mode while playing</td>
<td>–</td>
</tr>
<tr>
<td>![Current time]</td>
<td>Current time of playback or recording (the current cursor position in the waveform)</td>
<td>–</td>
</tr>
<tr>
<td>![Playback speed]</td>
<td>Changes playback speed</td>
<td>–</td>
</tr>
</tbody>
</table>

## Processing

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Normalize…]</td>
<td>Opens a dialog box with normalization parameters</td>
<td>–</td>
</tr>
<tr>
<td>![Change Amplitude…]</td>
<td>Opens a dialog box with amplitude correction parameters</td>
<td>–</td>
</tr>
<tr>
<td>![Clipping…]</td>
<td>Opens a dialog box with clipping parameters</td>
<td>–</td>
</tr>
<tr>
<td>Toolbar button</td>
<td>Action</td>
<td>Keyboard shortcut</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Resample…</td>
<td>Opens a dialog box with resampling parameters</td>
<td>–</td>
</tr>
<tr>
<td>Change Resolution…</td>
<td>Opens a dialog box with resolution correction parameters</td>
<td>–</td>
</tr>
<tr>
<td>Change Speed…</td>
<td>Opens a dialog box with speed correction parameters</td>
<td>–</td>
</tr>
<tr>
<td>Mixing…</td>
<td>Combines multiple signals into one</td>
<td>–</td>
</tr>
<tr>
<td>DirectShow Filters…</td>
<td>Opens a dialog box to choose the DirectShow filter</td>
<td>–</td>
</tr>
<tr>
<td>Analysis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Energy…</td>
<td>Opens a dialog box with energy calculation parameters</td>
<td>–</td>
</tr>
<tr>
<td>Windows</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New</td>
<td>Creates a new data window</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Link Windows</td>
<td>Links data windows vertically and horizontally</td>
<td>F9</td>
</tr>
<tr>
<td>Grid Mode</td>
<td>Customizing grid and enabling grid mode of data windows layout</td>
<td>–</td>
</tr>
</tbody>
</table>
Appendix C: The list of the vertical toolbar icons

The vertical toolbar is located on the left side of the SIS II main screen and duplicate some of the Analysis menu commands. Its buttons perform the following actions:

Table C.1 – Actions of the vertical toolbar icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Zoom]</td>
<td>Turns on the increasing mode</td>
</tr>
<tr>
<td>![2d cursor]</td>
<td>Turns on2Dcursor in the current data window</td>
</tr>
<tr>
<td>![Visualization Settings]</td>
<td>Turns on the visual tools to customize the display of data of the spectrograms</td>
</tr>
<tr>
<td>![Copy Screen Area]</td>
<td>Copies any part of the main program window to the clipboard</td>
</tr>
<tr>
<td>![Copy Window Image]</td>
<td>Copies the current data window to the clipboard</td>
</tr>
<tr>
<td>![Spectrum]</td>
<td>Opens a dialog box of the FFT spectrum building</td>
</tr>
<tr>
<td>![3d FFT]</td>
<td>Opens a dialog box with the FFT spectrum building parameters or builds a spectrogram with the given parameters</td>
</tr>
<tr>
<td>![3d LPC]</td>
<td>Opens a dialog box with the LPC spectrum building parameters or builds a spectrogram with the given parameters</td>
</tr>
<tr>
<td>![Cepstrum]</td>
<td>Opens a dialog box with the cepstrum building parameters or builds a cepstrum with the given parameters</td>
</tr>
<tr>
<td>![Autocorr.]</td>
<td>Opens a dialog box with the autocorrelation building parameters or builds an autocorrelation with the given parameters</td>
</tr>
</tbody>
</table>
Appendix D: Keyboard “Quick Access” Keys

For accessibility and efficiency, most common actions can be performed using hotkeys as well. A complete list of keyboard shortcuts is available when you open the Shortcuts window (Figure D.1): on the Help menu, click Shortcuts or press F1.

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows and Files</td>
<td></td>
</tr>
<tr>
<td>Open file</td>
<td>Ctrl + O</td>
</tr>
<tr>
<td>Save current file</td>
<td>Ctrl + S</td>
</tr>
<tr>
<td>Create a new window</td>
<td>Ctrl + N</td>
</tr>
<tr>
<td>Close the current window</td>
<td>Ctrl + D</td>
</tr>
<tr>
<td>Close all windows</td>
<td>Ctrl + Shift + D</td>
</tr>
<tr>
<td>Recording and Playback</td>
<td></td>
</tr>
<tr>
<td>Play/Pause</td>
<td>Space</td>
</tr>
<tr>
<td>Play entire signal</td>
<td>F6</td>
</tr>
<tr>
<td>Play the selected intervals</td>
<td>Alt + F6</td>
</tr>
<tr>
<td>Play the selected fragment</td>
<td>Shift + F6; Shift + Space</td>
</tr>
<tr>
<td>Play visible in window fragment</td>
<td>Ctrl + Space; Ctrl + F6</td>
</tr>
<tr>
<td>Pause</td>
<td>Ctrl + P</td>
</tr>
<tr>
<td>Start recording</td>
<td>Ctrl + R</td>
</tr>
<tr>
<td>Stop recording or playback</td>
<td>Escape</td>
</tr>
<tr>
<td>Rewind</td>
<td>Left</td>
</tr>
<tr>
<td>Fast forward</td>
<td>Right</td>
</tr>
<tr>
<td>Increase the volume</td>
<td>Ctrl + Up</td>
</tr>
<tr>
<td>Decrease the volume</td>
<td>Ctrl + Down</td>
</tr>
<tr>
<td>Loop On/Off</td>
<td>Ctrl + L</td>
</tr>
<tr>
<td>View</td>
<td></td>
</tr>
<tr>
<td>Link windows</td>
<td>F9</td>
</tr>
<tr>
<td>Manager panel</td>
<td>F10</td>
</tr>
<tr>
<td>Signals</td>
<td></td>
</tr>
<tr>
<td>Go to the next signal in window</td>
<td>Shift + Tab</td>
</tr>
<tr>
<td>Selection</td>
<td></td>
</tr>
<tr>
<td>Create the single mark</td>
<td>Ctrl + Double left mouse click</td>
</tr>
</tbody>
</table>

Figure D.1. List of shortcuts